Learn more.
See iMovie User Guide
and iMovie Suisport

s Keynote

Create professi onal, cutl ng-edge presentations with Keyrote. Start with one of the more tran 30 predesigned themes and make it your own sy adding
text, new objects, ad changing the color scheme. With Activity Stream, it's easier than ever to collalborate on a Keynote presentation and keep track of
every Change aong the way.

Organize visually.
Use the slide navigator onthe left 1o quickly add, rearange, or dal ete slides. Clide a slide to ses it in the main window, drag a dide to charge its order, or
select a slide and press Dd ete toremove it

Dirag to Add objects 1o See format and
(reorder slides. your slides.I animation options.
— L i EEY

Bocmain of the way thay
arow, nendihn shafl: hve

Thie bacuiful dhops is
thought fo have inspired
- dusign for the
spiral shoirerme

Collaborate in Messages,
Youl can send an nvitation to collaborate in Messages, and everyone on the thread is automatically added to the Keynote presentation. Qlick the Share
BUION iNthe mMenu bar, make Sure COIl BhOrats |5 56 ecied, 1hen Click Messages, Choose the rame of 1€ Groud yol wart 10 add as paricipants.

Work together in real tirme.
With Activity Stream, adetaled list in the sidekbar allows you 10 Se2 adits and commeants made by colazorators on a Keynote presgrtation. IS gasy 1o
follow each change, as well as who has been added to the Keynote presertation or any other fie maragemert changes.

Practlice makes perfect.
To rehearse YO preSentation, Choose Play = Rehearse Sideshow. Yol 588 eaCh S ide aiong with your Neies—ard a gock 10 kesp you N 1aCk.

| See how you're doing on time.

00:01:28

Spirals are ane of the most camman shapes in niture.

Remind yourself
of key points to make.
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Present inany situation.

Presert in personusing an extana display and use your Mac to view upcoming 5ides, presenter rotes, a dock, and a timer. Curinga videoconference,
tost a slideshow with other preserters, and control as you would when presentirg d one. Create an interactive presentaticn that the viewer cortrols;
cortrol your presentation remotsly using your iPhore, iPad, oF even your AB3IE Watch; and more.,

Shidre your presentation.
K your manager warls o review your jresertation or you want to share it with others on a corference: call, choose Share = Send a Copy to serd a copy by
IWail, Messages, Aibrop, or evensocid meda

Draw them in
Get their atter-tion by animating an okject on aslide. 5dect the object, clioc Arimate in tre todzar, click Actionin the sidebar, then click Add anEffect.

Tip:
Yol can include A video in your presertation. Clioe where you wartit1o be, then click the Media buton Gal
inthe toolar. Click Movies, then find the movie you want and drag it to your slide.

Use the Touch Bar on your 13-inch MacBook Pro.
Tap the arow Buttons to move up or down through your slides. Tag to zoom or skip a dide; or ta3 to group or ungroup slides. b presentation modes, you
see thumsnail s of your slides in the: Touch Bar.

Learn more.
See the Keyrote User Guide

£) mail

Mail lets you manage all your emal accourts from a single age. | works with most popular emall services, such as iClold, Gmnail, Yahoo Mail, and A0L
IMail.

One-stop email.
Tired of signing in to multiple weksites to check your email accounts? Set up Mal with all your accourts so you cansee all your messages in one place.
Choose Mail = Add ACCouUnt.

Ask Siri.
Say something like: "Email Laura asout the trin”

Find the right message.

Tyse inthe search field o see suggestions for messages that best match your guery. macOS Vertura imcludes a new smart s=arch that provides more
accurats resUlts, IS aware whien you make tyioos, ard searctes for synonyms for yolr search terms. Smart sgarch alse allows you 10 536 a richer view of
shared contert and more as you search for email messsages.
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Click to search for
an item in Mail.

e B oo 81 Pajn. o
et (Jé%m ; p o ,Oé) o‘s&

Click to Undo Send.

Managse your messages.
See onhy the messages you want to see in your inbox. You can block messages from specifc senders oy moving their messages directly to the Trash, mute
ovenly active emal threads, and unsubsorioe from mailing ists drectly in Mail.

Scheduled send.
With macOS Vertura, you can schedue an email fo ke sertat the perfect momert. Wi-en compos nga message, dick tre drop down menu next to the
Serd button. Select one of the suggested timesinthe list or Send Later to customize a date and 1ime.

Undo send.

Easily unsend an émail message that you just sent besfore it reaches the recipiert’s inbox. Click Urdo Send at the bottom ofthe sidsbar in Mail witin 10
seconds after serding. You can also customize hovy long you have to Lnsard an email Go to Mail Settings = Composing, 1hen dhoose an gotion in te
pop-us menu next to Urdo Send Delay.

Stay efficient and organized.
Mail notifies you if you forget to include an imzortant part of your message, like arecipent. Mail canirtdligertly move sert email messages hat did not
raceive a resgonse To the top nf your inbox. Then youcan guickly send a fol ow-up

Get reminded.
Select a date and ime to be reminded about an emal that you opered and didn*tget back to. Cortrol-didk ary email in your inbox, thenclick Femind Me.
Choose when you would like to be reminded ard the message will resurface at tre top of your inbox.

Snin
rEmDEMCT

K & Painy
=

Add everts and contacts right from Mail.
VWhen you recaive a message that includes a new email addres s or event, just click Add in the message to additio Cortacls or Calendar. Force click an
address 10 see a preview of the location, which you can open in Wiaps

Protect your privacy.
Privacy Protection prevents email senders from | earring information asout your Mall activity. I you turniton, T hides your IP address so senders can't link
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it to your other orling activity or determine your location, It aiso preverts senders from segeing if yolfve opened thair email. Turn it on in Mail Settings =
Privacy, then chedk Protect Mal Activity.

Hide your email address.

With an iCloudt subscripstion, you can create a unigue, rardom email address any time you need ore (for exame, when ccm eting a fomn on a welbsite),
with no limiit 1o the numizer of addressses you can Lse YWhenyou oeate aHide My Emal address for a site, you cansend ard receive messages without
having to share your real emai address and have that correspondence forwarded to the email address associated with your Agple ID

. You can create, manage, or disable a Hide My Bmail address at any time iniCloud settings on your Mac orin Account Settings on iGloud.com

. See Create unigue, random email addresses withHide My Ennail ard iCloud+

inthe iCloud User Guide.

Translate ina snap.
Select the text you wart to translate, Cortrol-dlick the selected text, choose Trandate, tren choose a language. To translate text you®ve typed, dick
“Replace with Translation.”

You can also download |anguages so you can work offline—on your Mac, choose Apple Menu @

> System Settings, then click General inthe sidekar. Go 1o langaage & Region enthe rig-t, dick the Trarsiation Languages button at the bottome Not all
languages are avallale. See Translate on Mac

imthe macOS User Guide.

Personalize any message.

Add emoji or photos with just a click. Select photos from your photo library o take them on iProneor iPad. You can aso add a sketch you ve drawn on
your iPhone or iPad. Tolea more aboutinserting photos and sketches from other devices, see Contiruity Camera on your Mac

and Cortinuity Sketch and Continuity Markup on your Mac

Add emoji. | Add photos.

|
Aa @ @~

View in full scregn
When you're using Mail in full screen, windows for new Messages automat cally open in Split View on the right, so it's easy 1o refererce another messace in
your inbox as yol write. See the Aople Support article Use two Mac agos side by side in Solit View

Filte ryour inbiox with Focus,

Fitter your inBox By accounts to get the messages that matter durirg a particd ar Focus. For examd g, silence work emails when you'te offine. Chocse
Apple Meru = Systen Settings, then dick Focusin the sidebar. SelectaFocus on treright clids ),

and choose Add Filter under Fcous Filters. To leam more azolt addirg or cLstomidrg a Focls, see Set Lp a Focls on Mac

Never miss an email.

Check the Mail icon in the Cock 1o 5ee the number of Lnread messages, YWhen you get a new email, arotfication aso aopears at te top-right of tre
5Creen 50 yold £an quitk y preview incoming messages. Dot want notificat ors? Te 1urm them off, open Sysiem Settings

, Then clids Motifications in the sidear. Go to Appli cation Notifications on the right, then dick Mail o configure your rotification settings.)

You have unread
messages.

CJ i VS
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Use the Touch Bar on your 13=inch MacBook Pro.
Use the Touch Bar for many common tasks, ke composira, replyirg, archiving, markirg as junk, and flagging messages.

Customize: the Toudh Bar to add your favorite cortrol s (choose View = Customize Touch Bar). See Custormize the Touch Bar on the 13-inch MacBods Pro

Ledarn more.
See the Mail User Guide

| 1%

o Maps
Getdirectionsand view [Dcations Lsing a mapo or a satelite image. Get recommerdations for the best places to visit in acity: with guidescurated by apple
Force click a location o drop a pin there.

Explore indetail.
hMags shows more details o help you discover what's out trare, including landmarks, elevat on, natural f2atures, a-d more. On yolr Mac with Agple silicon,
rew city experiences offerdetdls like landmarks, buildrgs, ard eventrees

Plan your route.
Use the new driving mag to iolan your routes, check for traffic, and see road detals, likes turn and bus | anes. Ran routes with multiple stoss and
aLtomatical ly view them on your iPhore or quickly share directiors with a frierd via Messages.

Find and save your favorites.
Fird what your're looking for and filter the results. Qick on a place 1o learn imgcor@art irformation, like opening hours for a business or whether a restaurant
offers takeolt You can savs the places you go most often to your favorites.

— S Franciacs Canty.

©) ortiem - Shunalis:
o= -
3 de Young Museum
G

Daly City

Ask Sid.
Say something like: “Find coffes near me.”

Discover new places with guides
To hesls you discover great dlaces around the world 1o eat, shop, and exd ore, Mags offers curated guides from trusted brands and partrers. You can save
these guides and get updates whenever new places aeadded,

Create your own gui des.
You can create your own guides for your favorite [ aces ard sare them with friends ard family To oreate a guide, move the pointer over My Guides in the
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Sdekar, dick @
on the rig-t, then Cortrd -dick the new guide to see a menu of oistions

Explore in3D.

Cligk Look&round 58

to expdore select citiesin 3D as you move smootHy throughthe streetsin anirteractive experience. On your Mac with Apple silicon, you canuse the
irteractive: 3D Globe 1o experience the Earth’s natural beauty.

See indoor maps for major destinations.
Fird yolr way arouind select ainports and shomsirg mal s Just 2oom in 1o seg what restaurarts are near your gates, find a restroom, plan a spot 1o meet up
with fiends at the mall, and more.

Show or hide directions.
Open or close
the sidebar. Shaw your eurrent location.
Cuter Aot — San Frascaza 7 =
s _a arm &
Mearby Transit

Bus Lines

Get there on public transit.
Majss provides Nearizy Transit information for select cities including wpcom rg departures near yow Click a destination in the sidebar, then click &
10 get suggested travel routes, trarsit fares, and estmated travel time Pin your favorite transit lines so trey dways show up at the top T they’re nearsy.

E¥ trip planning made easy.
Add your electric vehicle to your iPhore, and Maps shows wou whesre The charging stations are aong your rolte, and accounts for charging times when
CalCdlating your ETA.

Plan your cycling route.
Mass gives you the info you need to plan your cyding trip, suth as devation, traffic cordtiors, and whather here are sieap inclings. Afte you Jan your
thp, you can send itto your 1Phone.

Get live ETA updates.
When fliends and family share heir ETA with you, WMaiss Can show yol whre they arg aong their route.

Maote-
Some Maps features are not avalalzig inall countries or regions

WARNIMNG:
For important information alzoLt navigation and avoiding distractions that cou d lead to dargerous situations, see Impottart safety information for your Mac
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Tip:
To see what traffic islike click The View menu in the menu bzar then choose S-ow Traffic,

Learn more.
See the Maps User Guide

L. Messages

With Messages, it's easy fo stay in touch, no matter what device yolre Usirg. Marage group texds, gn favorites to the fop, easily view cortent shared with
you by others, ard much more. You can send text messages to aryore with a Mac, iPhore, iFad, iIPod toudh, or Apple Watch usirg iMessage, ard send
texts 10 others using SMSMNMS. See the Apple Support article What is the dfference between iMessage and SMSMMS?

Start a conversation. Start a FaceTime call.

o o W eratiaeat Waleome: Cravw — Manage

a conversation,

share your
Miemdbeais

location,
and maore.
ot

@

el
&3

2 O

Rt Oish

siriszin Goldsworihy

o

Urlimited messages with Message.

¥hen you sign in with your apple ID

¥OU Can exchange unlimited messages—inciuding text, potos, Live Photos, wideo, and more—with aryore witha Mac, iPhore iFad. iPod touch, o Appie
Watch. The Messages app Lses iMessage to send ercryoted messages to these devices that appear in blue bubiles inyour conversations. For setup
irformation, see the Apd & Support article Use Messages on your Mac

Send SMS/MMS.

If you're not using iMessage, you can send and rece ve S ard MMS messages on your Mac if your iPhone withiOS 8.1 or later) is sighed in to
Messages with the same: Agple ID as your Mac. On your iProne gofo Settirgs > Messages tap Text Message Forwarding then tap the rame of your Mac
e tum on Text Message Forwarding. On your Mac, youl'll see an activation codeif you're not Lsing twe-factor authertication for your Apple 1D Enter the
code on your iPhone, then tap Allow. SMS and MMS messages aren’t encrypted and appear in green bubHes inyour conversations.

Ask Sin.
Say 50MEthing like: "Message Mom that Il b2 ate,”

Unsend and edit messages.
When conmunicating in Messages, you Can ursend a recently sertmessage for up to 2 minuies after sendingit or edita recertly sert message up to five
times within 15 minutes after sendirg it. Cortrol-dick ary sertmessags and clide sither Undo Serd or Edit

Mark a conversation as unread.

Youl can marka message as unread 50 you can return to it [ater wihen you have time torespond. Control-clck the read message inthe messages list, then
click Mark as Unread.
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Keep favorite corversations at the top.
Pin your favorite conversatiors 1o the fop of the messaces list kv dragaing them o the top, New messages, Tastsacks, ard ty@ngindicators appear atcove
a pinned corversation. When there are unread messages in a group conversation, the most recent part ciparts aopear arourd the pinned corversation

Manage group conversations.

Make it easier to identify a group by setting a proto, Memoji, o emoiji as the groupimage. In agroup corversation, you can directa message to an
imdividual by typing the person’s name or usingthe @sigm, and you can respond to a guestion or statement earlier in tre corversati on by adding your
commert as aninling reply. YWhen a conversation becomes too active, you can hide alerts for the conversation. To set a group image and see ogliors for
managing a conversation, select the conversation in the list, tren dick the Details botton U

inthe top-ight comer of the Messages windowv. To receive a rotification when you're mertioned, open Seftings, clids General, then select the “Notify me
when my Name is mentoned” checkibox.

Make messages fun.

Liven L discussions Ly responding to messages with Memoji stickers, Tapkades, trendirg GIFs, or Sspecial effects like flcttering confetdi, alloons, and
more. Messages automatically generates sticker packs based on your Memo) characters. To add a Memoil sticker to a conversaticn, click the Aops button
O .

click Memoji Stickers, then click the: ome that best expresses yourmood. To add a Taskack, click and Fold a messace, then choose a Tapgosack. To add a
GIF or special effect, click theApps bution € ,

Choose #images of Message Effects, then dick the one you wartto use ard ook oLt for Digta Touch, invisible ink, ad handwtitten messages that your
friends send you from their iPhone, iPad, or Apd e Watch

Add a photo, sticker,
video, or effect.

% Photos
| @& Memoji Stickers
- #images

- Message Effects -

Create your own Memoji.
Dessign your own personaized Memoji —choose skin color and freckles, hairstyle and color, fada features, and more. Touses a personalized Memoiji as your
Messages pphoto, Go 1o Messages = Settings. Cliok "Set up Name and Photo Sharing,” dick Cortinue, tren click Customize. Click the Newy Memoji bution

3
1

therclick each feature to design your look. YWhen you finish, dick Dore to add the Memoj to your sticker collection. To add more Memoiji to your
col ection, open a corversations click the Apps button @),

click Memoji Stickers, click the New Memoji bution + ,

ther have fun designing.

8Send a file, photo, or video.

Easily share files by draggirg trem to Messages, Or guicky find ard serd photos and videos from your Photos lilrary. In a corversation, click the Aois
button €,

click Photos, then click a ptoto to add it Type a keyword —for exangde, a person’s name, date, or location—in the search field to help you fird a specific
photo.
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Easy photo management.

When someone sends you mul ple photos, two o three photos apoea as a collage you can view at a glance, a~d four or more phetos are gathered ina
stack. If you have atradspad or Magic MoLse, swipe |&ft or nght on the stack with two fingers to see each photo witholt opering it. Control-dick a phcto
10 OBeN i, reidlyt0 i, OF add a Tapkack. To QuiCkly Save @ photo 10 Photos, Cli gk the Save Phote button i

Nextio it To open al the photos INthe stack, doulsle-clidk the stack,

Shiared with You,

Cortent sert to you over Messages by people in your Contacts avtomatically aigoears in a new Shared with You sectionin the correspording agp, 5o you
can enjoy it when it's conveniert for you. Shared with You conter-t appears in Photos, Safari, Aigole News, Agpple Podcasts, and the Agole TV app.
Alongside shared cortent in the corresponding aops you cansee who sert if, and with a dick, gzenthe assocated conversation in Messages so you can
cortinue the conversaticn while you're erjoying what was srared with you.

Tip:
To see all the photos in a corversation, click the Details kutton (0 .

Collaborate on projects.

You can send an iwitation to collaborate on files, Keynote presertations, Numisers spreadshests, Pages documents, Notes, a-d more. Inthe app you
wauld like o USE 1o collaborate, click the Share iutton, make sure that Collaborate is selected, ten dick Messages. Chogse the rame of the group you
wart to add as participarts, and everyone on the thread is autornatically added to the document, spreadsheet, or other shared file. When someone makes
an edt, you see activity updates at the top of the Wessages thread.

Shidre your screen

Yol and a fiend can share soreens and even open folders, create documerts, and copy files by dragging them 1o the deskiop on the shared screen Click
the Details button (0,

thenclick the Screen Share button 8.

Watch and listen ogether.
Join a SharePlay session via Messages to watch and listen togeter on Mac. Youcan dso share yourscresn durng a FaceTime cdl, SeeShae
experences with SharePlay

Maote-
Some apps that supsort SharePlay require a suCscrifstion 1o particisate. Mot all features and contert are availade inall counties o regors.

Filte ryour messages with Focus.

See only the messages you want o dunng a parti ol ar Focus. For example, for a Gaming Focus., just see conversations with fiends wouusually play with in
multilayer games. Choose Apple Menu > Systen Settirgs, tren ol ck Foaus in tre sidebar. Select a Focus on the rights click )
and choose Add Filter under Foous Filters. To learn more 2izolLt addirg or cLStomizirg a FocLs, 588 Set Lp a FooLs on Mac
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Use the Touch Bar on your 13=inch MacBook Pro.

Tap

1o oeate a new message. Tap the typing suggestions to add words, ad tap ©

10 568 emoji that you can add o your message, Cli ck 2 message in e thread 10 586 Tapbacks on the ToLch Bar, and tap 1o add tem,

veSOR®4Ld @

Learn more,
See the Messages User Guide

Music

Thes Apple Music apz makes it easy to organize ard enjoy your iTunes Store purchases, songs, and albums inyour persond likrary, and in the Aople Music
catalog {which lets you lister o milions of songs on cemard). Qick to view wi-at's next, mrevicLEy played tracks, and lyrhcs for what's playirg. Sop for the
music you wartin the iTunes Slore.

I¥5 in your library.
You can easily view and play your iTunes Store purchases, items you added from the Apple Mudc aatalog, and musc in your personal lirary. Filter your
cortent by Recerdy Added, Arists, Allbums, or Songs.

Browse thebest of Apple Music.

Clids Browse in the sideloar 1o see new music and exclusive releases from Apple Mus ¢, a music streamirg service available for a morthly fee. Steam and
downioad more than 50 million sorgs ad-free, and d-oose: froma large selection of [Jaylists o find the perfact mix for any momert. You can now follow
wour favorite artists 1o receive new music notificati ons and recommerdations of other artists you mig-t erjoy.

View items Hear the latest Sea what will
i your library. ITD[_| Picks. play next.
i | .
Ty Listen Now a

Ton Pieks

Recentty Playes

Bing along.
Cligs (2
iNthe toolbar 10 dSplay A parel with [yrics for 10 cUvert 50ng (f available).

Tune in.
Clids Radio in the sidebar to tunein to Apple Music 11ive or listen 1o 8y episode from the Ao e Music family of sShows, Explore the varicty of stations
created for almost svery genre of mMusic.

O ask Sini.
Say something likes “add this song to my lisrary.”
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Sync with ease.
Sync wour music cortent direclty in the Apple Music as. Ywhen you connect a device, you see it in the sidebar of tre Finder. JLst drag the cortent you
wart oo your device, You can also back up and restore your device in tre Rnder.

Listen together.

Use SharePlay tolisten tomusic in real tme with up to 32 friends. Start by brirging the grouz together ina FaceTime call, then dick /a0 -

To start listening, move the poirter over ary song or alblm in the Music gapp then click the Play iutton Everyone hears the sanme music at the same time,
Fasacceass to shared playback controls, amd can add or rearange sorgs in the stared music gueue, And with smart volume, awdio isadjusted
attomatically so you can hear each other evan durirg a loud passage. See FaceTime

and Share expen erces with SharePlay

Note:
To use SharePlay, you must have macOS version 12.3 or later o your Mac, and iPadOS 154 or later on your iP ad. Some apps that sugport SharePay
require a subscoription to partiapate. Notall features and cortertare avalablein all countries orreg ons.

Buy it on the iTunes Store.

If you wart to own your music, olick iTungs Store in the Sdekar. (i you don't see the store inthe 5 dekar, choose Music = Setlirgs, click Genera, then click
Show iTunes Store.)

Tip:
When screen real estate is at a premum, switch to MiniPlayer to open a smal float rg window that you can drag wiere you wart, 50 you can listen and
cortrol your music while doing other things on your Mac. To ogsen Min Player, choose VWindow = MiniPlayer.

Use the Touch Bar on your 13-inch MacBook Pro.
When you're b aying a song, you see the rewind, play/pauss, ad fast-Torward buttons in the Touch Bar

Learn more.
See the Aple Music User Guide

N News
Apple Newsis your one-stop destination for trusted news a-d irformation, curated by editors ard personalized for you. You can save artides for fuiure
reading—even offine or on other devices. Apsle News+ lets you read Fundreds of magazires, popular nevwspagers, ard premium digital puldishers ora
sngle monthly price.

Thes newvs feed features prominent Iylimes and pLdication datess, making it easy fo Browse: and verify stories. Save storiesright from e rews feed 1o read
later or share. News+ subtscribers get a more rolust search featiure ard the Mews+ Library, which organizes your cortert oy magazines, dowr-load ed,
newsgapers, and catalog—so it's easier 1o get to your favortes
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Did Anclent Supernovae These Are the 10 Friendliest
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Pl fuertial crastnt it Srticurs T Liisg o

Maote
Apple News and Apple News+ are not avdlaizlginall countries or reg ors.

Custormnize your feecl
Follow yoLr favorite channels and topics to seetheminthe Today feed ard sidezas Bnter a news outiet or togic inthe seardh feld, tren olice +
1o follow it. To make it more prominent in the sidezar, Control-click the dhanrd and clide Add to Favorites.

Follow your favonte teams with My Sports.

My Spors lets you follow your favorite teams ard Igagues; receive stories fom sports pusi cations, Iocal rewspapers ard more; ACCEss SCores, SCredu es,
and standings for the top professional and college |eagLes: and watch highlights, Open the Today feed, scroll down to My Sports, and dick Get Started fo
start following your favorite Spors.

Tip:
If you're reading anarticle and wartio saveit for later, choose File » Save Story. To view the article later, click Saved Stories near he too of the sidebar.
You can access arfides from ary of your devices when you s gninwith the same Apple 1D

Shared with You.
When friends in your cortacts share: stonies with you in Messages, they actomaticaly aggpear in the new Shared with You section in the Today feed and in
the sidebar of Apple News. Stories found inNews ad Safari aszear in Shared with You in both apps—so you can erjoy them in either place

Use Quick Note to save and organize articles.

If you're doing research for a project or upcomirg vacation, youcan add a Quick Note to anews story and tag it to save it for later. In News, pressFn-Q or
Lss aspecified Hot Comer 1o open Quick Mote and save tre aricle link. You canfind the Quick Mote later inthe siddhar of the Motes

app.
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Learn more.
See the Apole News User Guide

Notes
Notes is the Pest place to capture guick houghts or save longer notes with chedelists, images, web links, and more. Coll alorati on features—|ike shared
rotes and folders, mentions. ard actvity wiew—make it easy to work with others and stay updated about what's haspen nginyour note. Youcan also keeg
organized with Tags, or use Smart Folders to actomaticaly arrarce your rotes based on critenia like whether your nole has cheddists o attadhmerts, when
the note was created or edited, and more, And with iCoud, it's easy tokesp al your devices n sync, 5o you aways Fave your rotes with youon ary device
whers you're sigred inwith yolr aople 1D

O Ask Sin.
3ay something likes “Create answ rot”

Add content, lock notes, and share thern.

Use the Notes ool bar to qui ckly add checklists, protos, videos, skeiches, tables, links, ard more 1o your note, Click &

10 ook your note with your MacBook Prologin password or create a sgpaate password, Share a rote with Mall, Messages, Remindas. or ArDropky
clicking (1,

choose Send Copy, then choose how you wart to share.

Add a checklist, table, Collaborate or
photo, scan, or sketch. | send a copy.
B4 Ao 8- BB @~ & a~v M Q
'Change text format. Addd !ink' 'Luck note,

Collaborate onanote.

You can send an nvitation to collaizorate on a note in Messages or Wail, or copy and share tre link. Click

inthe toolbar, choose Cdllakorate in the menu, then select Messages, Mail, o Cooy Link. If you share trelirkin Messages, everyone onthe thread is
aLtomatically added tothe (ist ONCe YO ve invitBd othe's 10 jin, yol CaN tratk aCtivity aNd Manage Collaboration kay oicking 49 .

Add tags.

Use tags arywherein the body of your note 1o categorizes ard organize them. Ty e # symbol followed by your tag text. You can view yolr tags in the
g deksar to quickly jumnp 1o notes with a specific tag or tags (for example, #vacation or #oooking). Customn Smart Folders automaticaly collect rotes in ong
place based on the same: tags.

Use mentions
Add mentions (type @ followed by a name, for example, @Ledlie) 1o comnect directly with your coll dsorators on a projector in a socia setting They'll get an
alert that they ‘we been mertioned in a note, ard they can jumprightin ard participate.
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Add tags and Wiew the summary of your
menticns., cellaborators' updates.

ece < ni 2

BIO 4810 Shallow Water Ecology Case Study Notes

whe lives In Monceney Bay's reafs?

Browse your tags,

View anote’s aclivity sunmary.
See the |atest updates asout who's been working on a shared notein the Activity vi ew on the right side of the Noles wird ow. Swice right on note text o
Wi ey editor callouts showing highligh-ted changes and the date and ime the note was edited.

Organize with Smart Folders.

Smart Folders make it easy 1o guickly amangs your notes by tre filters that you set up. You can fiter by tags, mertions, the date a rote was created or
edited, if the: rote: was locked or pinned, Quick Notes, and more. You can add mitiple filters to a Smart Folder ard choose whether al o ary are
applicasie. To get Started, dick New Folder in tre lower- eft coTer, name your folder, then select*Make irlo Smart Folder,” then acd the criteria you want

Add a Quick Mote from anywhere.
With Quidk Note, you can create: a notes from any app o website on your Mac and viewitinthe Quide Notes category in the Netes sidefar.

To create a Quick Mote, use the keyboard shortcLt @

-G or move your poirter to the lower-right corner of the scresn, where Qui g Note is accassible by defaultt as aHot Comer. InSafari, you canoreatea
Quick Note by highlighting text on a webpage, then cligk Share

= Acd Quick Mote to add the highlighted text to your note.

Notes
To create Quick Notes using a different Hot Corner, go to System Settirgs @
> Desktop & Dok, then dick Hot Cormers and choose a corner o assign fo Quick Note.

Adjust the size or position of your Quick Mote (draga correr 1o resize the Quick Mote or drag the titl e bar to repogiticn it), so it coesn't blcek what you're
W EWing.

Custornize your toolbar.
Cartrol-Click arywhers in the 100! bar 1o 05N the CUstomiZe ToOlzar window, Drag your favorite temsirio & 00lbar 10 make it wor for you

Use the Touch Bar on your 13-inch MacBook Pro.
Tap

1o oreate anew Note. Tap @

to add a checkist itemto yolr notes.
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Tap )
to disglay text formatting buttors to aign text left or right and apply bold, itaic or Lnderscore styles

Tap Ad
to Lse note paragraph styles, ke numisered lists, Bulleted lists, or headings

© Title  Heoding

Ledrn more.
See the Notes User Guide

) Numbers

Use Numbersto create attractive and powerfdl spreadshests on your Mac. More tan 30 Apple-designed femiplates give you a head start when you Greate
budgets, invoices, team rosters, ard more. Numizers can also openand export Microsoft Bxcel soreadshests. With Activity Stream, it's easier than ever 1o
collakborate ona Mumicers spreadshest and keep track of every crangs along te way

Start with atemplate—then add what you want
Select the sanpie text in the template, then type new text. To add images, drag a graptic file from your Mac 1o the placeholder image.

Add objects like View formatting options
shapes and charts, for the selected ohject. I
s
[0 Promiity 4o parks; { o2}

PET HOTEL & DAY CARE 1 gl ping scrers Codar 8

Collaborate with Messages.
Youl can send an nvitation 1o collaborats in Messages, and everyone onthe thread is automaticaly addad to the Numbers soreadsheet. Qick the Share
button inthe menu bar, make sure Coll @borate is s ected, and then dick Messages Chroose the name of the group you want to add as paricipants.

Work together in redl time.
With Activity Stream, adetdled list in the sidekar allows you 1o seeedits and comments made by collazoratars on aMunbers spreadsheet. s easy 10
followy each change, as well as who has been added to the sareadsheet or what fie managemert updates have cocurred.

Get organized with sheets.

Use multide sheets or tabs to show different views of your information. For example, use one sheet for your lbudget, ancther for a fable, and a third for
rotes. Click +

{0 add a new sheet, Drag a tableft or right to reorder sheets.
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Click + to add Drag a tab left or right
a new sheet. to reorder sheets.

ot ool enovaton

Formulas dre a sap.,
Get buit-in halp for more than 250 powerful functions—just tviog the equal sign{=) in acdl, ard you see alist of all the furctions and their descrigtions in
the sidelsar. Start tyzing a fomula to get instart suggest ons.

Tip:
To get instart ca culations for a series of values, select the range of cdis cortaining the values. At the botiom of the window you’ll see the sum, average,
minimum, maximum, and count of the selected valuss Clids the Meru button G
at the bottom rig-t to sees aven more options.

Create pivot tables.

Create apivottalbe using atalb e or range of c8 IS in a Soreadsheet as your source data, them use it o ard yze any set of data, guickly group and
summarize values, and idertify interesting patterms ard trends. You can edit e cell rarge of your sourcz data, add and arange pivottade data, create a
sapshot of a pivot table that you can copy 1o ot apps, and more.

Use the Touch Bar with your 13-inch MacBook Pro.
Tap Format, Avtofill, or Formula to display the ootions shown elow. Tap text style ard format buttons to display more options for choosirg color,
justification, wraisoing, and topAsottom alignmert for text

Learn more.
See the Numbesrs User Guide

Pages
Use the Pagas aino to create stunning, media-rich documerts ard books on your Mac. Open and edit Microsoft Word figs, and track changes made by
yourself and others. With Activity Stream, it's easier tran ever to collasorate on a Pages docLmesrt and keep tradk of every change alongthes way.

Look good!
Pagss includes professiond. ready-to-Lise templates for books, News etters, reports, résumes, ard more, makirg it easy to start your project
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Add charts, maovies, Open or close the
and mare. Format sidebar, |

Collaborate with Messages.
Yol can serd an invitation to collaborate in Messages, and everyone onthe thread is astomat caly added to the Fages documert. Clids the Share button
inthe menu bar, make sure Collaborate is selected, and then click Messages. Choose 1he name of the grous you want toadd as participants

Work together in real tirme.
With Activity Stream, adetailed list in the sidestzar allows you 1o see edits and comments made by collasoratars on aPages document. i's easy 1o follow
each change as well as who has been added 1o the Pages document or what fie management updates have occurred.

All your formatting tools, in one place.
Clidk thes Format button #&
inthe toolbar to open the Formatinspectorn. Select something in your document, and the formatting options for it aprear.

Flowr text around graphics.
When you add an image 1o a text document, the text flows automat cally around the image. You canfire-une how the text wrags in the Formnat sidetzar.

Lo fowim qqulse ficqui ting eigalt illandgnim zovit Lores fesim eputsailil sing eugan ullandignim zavit
ustrud doluptatvalum || lustn iat, sum delor tat
walabor autpat alisim
quipls nit iune vandrerit
euganing etad
magnim ameansa min
corpar i hersat

vl chl il wolie 1 dputet \tAT SE AR ianbaguat.

3 L
Move a graphic into a text block... ..and the text wraps around the
graphic automatically.
Become a publisher.

Fages comes with bOok temdates that I8t You Creatgirieractive books in EPURB fomat. Add text ard images—and even a takle of conterts. When youre
ready, You can make your Book availaldle for purchase or download in Ao e Books.

Start on your Mac, finish on iPad.
Yol can keap documents up to date across aAll yolr davices when you sign inwith the same Apple 16
. So you canstart composirg on one device, and pick up where youleft off on arott-er.

Translate ina snap.

Select the text you wart fo translate, Control-dick the selected text, croose Trangate, tren croose a language. To translate iext you've typed, dick
“Replace with Translation.” You can dso download languages so you can work offine—go 1o tre Language &Regon settingsin System Settings, then
click the Translation Languages button at the lsottorm Not dl languages are avalale. See Translate on Mac
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inthe macOS User Guide.

Tip:
Tum on change tracking to see the changes you and others make to a dooament. Each ipersons edits and comments are color-coded, so you can see who
made each changes Choose Edit > Track Changes to show the cirarge tradking toolbar.

Use the Touch Bar wath your 13-inch MacBook Pro.
Tapto change the paragraph stylg, and 1o add tyig ng suggestions

Tap )
10 see more formatting cistions, thentap to choose text color, stve ostions (bold, falic, and so onk line spaarg, and bullet and list formats. Taz <EE]
1o returm to fying suggestions.

Tap the shye (for examples, Body) to see other paragraph formatting optiors, like Title, Suistitie, and Heading Tas ®
when you finish,

CAFTION

Learn more,
See the Pages User Guide

% Photos

Use Photos and iCloud Photos to organize, edit, and share your photos and videos, and keep vour pthinto library up to date on all your devices. Photos
showcases your best shots, and with mores powerful search options, it's easy to fird and erjoy your favorites, Easy-to-use editing tods let you transform
YOour photos and videos like a pro. And now with iCloud Stared Photo Likrary, you can sharg an a bum with Up 1o five other peopie, ard everyons can acd
photosand videos, organize and commert, and erjoy each other's dhancas.

Automatically create Wiew your photos by

a personalized videa Years, Manths, Days,
of special moments, \ar All Photos.

All your photos on all your devices.

With iCloud Photos, you can browse, search, and share al 1he plotos and videos fromall your dev ces that are sigred in with the same Sode ID

. V¥hen you use your iPhone to take a photo, it autormatically aspears on al of your devices. And if you edit photos, those edits aprear onal of your
dewices. To get started, open System Setlirgs

, Cligs your A2le 1D in he sidezar, click iCioud, tren m o Photos Telearm more, 568 16 Apnle Susrort adicle Set Lo and use iCloud Pretos

Set up iCloud Shared FPholo Library.
Share photDs and videos in a separate library 50 that everyongin the family can enjoy more completes memorigs. Cortent in the Skared Liorary 3o06ars
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seamiessly alongside your personal cortentin tre Photos aigo. YWhen someone adds a £hoto or vidso to the Shared Likrary, o makes anedit, tese
changes appea for everyone who is part of the library. You can participate in one shared library 1hatis shared with Up to five other people.

To set up iCloud Shared Photo Lilbrary, you must be signed in with your &3ole 1D and have iCloud Photos funed on. Go to Photos = Settings, dick the
Shared Library tab, then choose Get Started. You can add participarts right away, o choose to add them later. Select which of your past photos and

i deos you wart to add to the Shared Library: al wour photos and videos, photos and videos with certain peosle or taken after a certain cate, or select
photosand videos manudly. After the Shared Licrary is set up, you can toggle between viewing your Personal Libray, tre Skhared Library, orboth libraries
at once in Photos.

Add photos and videos to yvour Shiared Library.

To move irdividual photos o videos 1o Yolr Shared Lilrary, Control-click the ihoto or video n your Persomal Library and choose “Move to Shared Library.”
Tr use suggestions for photos or videos you may wart to add, go to Photos > Settings, clide the Shared Library 1al3, then check Shared Library
Suggestions and cheose “Add Peosle” 1o receives suggest ons of photos or videos with S8l ected peod e.

See suggestions Choose to view Personal
far your Shared Litzrary, Shared Library,
(Library, (or Bath Libraries,

For Your Shared Library

Shiared with You,

When friends in your Comtacts send you photos in Messages, they actomatica ly appear inyour PHotos &z, in the Shared with You secticn. Phctos that
wOUI re most likaly 10 care aoout, sUch as events youl atisnded, aspear inyolr liorary. Vhen you're viewing the photos in the Photos api, you can dick tre
message buitble on a photo to open Messages and cortinue the conversation.

Edit like @ Pro.

Create standoLt Photos and VicS0S with OWerful but Basy-10- LSE editing 100 5. USS 18 &ditirg bUoNS ak0ve ¥OUN DhOIO OF WdBO toimprove it with st 2
click. For more powerful editing todls, didk Edit, thenLss Smart Sliders o get professional resuiis. You canadd flters, rotate, increase exposure, and crop
both photos and videos.

Irteract with text.

Live Text recognizes text inimages on your computer and on the welb. You can copy text from a photo to paste into ary file on Mac, o click a prone
rumnier or website in the image 1o call the number or oppen the website, To frand ate text, sd ect the texty Control-clics ity therm dick Translate, Not dl
languages are avalasle. Sea Translate on Mac

inthe macOS User Guide.

Relive meaningful rmoments,

PHo1OS highlichts imBortant momerts ke birhdays, anniversanies, and P& Yol photo library comes io | fe with Live Photos and videos that begin
playing as you scroll. Qlick Memories in thes sidelar to have Photos creates a memorald & movie—comgplete with music, tilles, moods, and transitions—ttat
you can perscnalize and share. Your Memories ars avai able on all your other devices that useiQoud Photos.

Fine what you' re looking for.
Phiotos showcases the best shots in your library and Hides dudicates, receipts, and screerstots. Click the buttors 2t the top of the Photos wircow to view
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photos by year, morih, or day—or olick All Photos to guickly view your ertirg collect on. Photos idertifies oojects, scenes, ard peosle invour photos and
Wi deos so you can search your photos based on what’s in them, the date they were taken, people you've named in them, castions you added, ard thar
location—if provided. Yol can aiso use Seoflight and Siri 1o search for photos

O ask Sini.
Say something like:s “Show me photos of Ursula™

= Golden Gate Bidga

People, places, and things.

Visual LookUB recognizes mary objects in your [otos. Swige up on a photo or dick te informat on bLtton ona photo tohighlight recognized ofsjects and
scenes, Learnmore altoutpopula art and |andmarks around the world, plants and flowers, books, and breeds of pets, To have photos of people imgzortart
0o you always appear at the top of the People allbum, dick the Faveorites buton O

that ajgpears on their photo. Use the Places dlibum to view all your photos withlocation data on an interactive map. Zoom in onthe map to revea more
photos froma specific location.

Tip:
You can add location info to ary photo. While viewing the photo, didk the Informat on button (),
click Assign a Locat on, and start typing, Choose a location from the list, or type the location ard press Fetim.

Get creative with Live Photos.
With Live Photos, use the Loop effect to continualdy loop the action, o use Bounce to @ ay the animation forwad and backward. For aprofessord DSLR
look, use | nng Bxzosure fo Blu- motion in your Live Photos and tum an ordinary waterfall or flowing streamirto a work of art.

Use the Touch Bar with your 1.3-inch MacBook Pro.

Thes Touch Bar digplays a scruber with dl the photos and videos in your library, which you can use to speed your seardh for just tte right photo. You can
tap to mark a selected photo as afavorite O,

rofate it ',

O add it10 a New Or 8Xi5HNG allzum.

When you Edit @ photo, 13p BUHONS 10 oo, apply filte's, adjJst light, CO Oy, 3Nd Other Settings, or rétoUCh YoLr Select on IS8 additiora ootions, SLth as
enhance i,

compare 80,

and more; depending on your selection in the previols ToLch Bar.

Learn more.
See the Photos User Guide

Podcasts
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Use Appdles Podecasts o browvse, subscribe, and listen to favarite podcasts on your Mac. Personal recommendations hels you discover newy jpodcasts
grouped by tonics you care abolt

Get started with Listen Now.

See new episodeas for the podcasts youre sulsscribed 1o, as well as pasoralized recommerdations for podeastsyou might beirterestedin all inong
place. Vvhen you're signed in with your Apple ID

, 8y podcasts yol're still listening to are Saved in Listen Now, evenif you stared listering on another device.

O Ask Siri.
Say something like: *Continue playing the last podeast”
o "Follow this podceast.”

Haw & Wty

Discover new podcasts.

Fird topic- and show-based suggestiors for mew podeastsin Listen Now, o see which shows are trerding in Top Chrarts. K you se2 a show you like,
guzscrioe tothe podoast or add an episode to yolr library for later You'll get sucgestions for 5 milar topics and shows isased on what you erjoy and ses
the recommendations your friends make in Shared with You.

Shared with You.
When friends in yolr COMACts Share podoasts with youl in MESSages, the 8pisodes automatically appear in the New Shaed with Yod S8ction of LSten Nowy
in&zple Podcasts.

Save episodes 10 your library.
To save a §ingls episads to your liorary, dick +.
To kexep up with new episodes for an enfire podeast, dick Subscribe. To dowr cad a podcast for offline listening, click <5 .

Sedrch by hOst Or guest.
When you search for a specific topi ¢ or person, you can see resubts for shows they Fost, shows that theyre a guest on, and even shows where they're
mentioned or discussed.

Follow yourfavorites.
Clide Foliow to add a show to your favorites so that you never miss a rew e sode. See what's new intre Recenty Updated section of your liorary.

Saverideas with QuCKk Note.

War-tto remember apodcast for your mext road 1rip or to lister to while working out? Just create a QlLick Note to save the information so you can essily
find it later. In Podeasts, press Fr-Ct or use a spedifed Hot Comer fo open Quick Note: and save tre podcast link. You can find the Quick Note later in the
Sdelcar of he Notes

aPic.

Tip:
Yol can use AirPlay to play a podcast, music, o radio through an exterral speaker. Click the Control Center icon &
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inthe menu bar, dick Screen Mirroring, then select an available speaker.

Use the Touch Bar with your 13-inch MacBook Pro.
V¥hen you listen to a jpodcast, Lse the Touch Bar to pause or resume playing, or move forward or back by slidrg the marker on the scruksber bar.

Ledrn more.
See the Apple Podeasts User Guide

== Preview

Use the Preview aop 1o visw and make changes to PDFs and images, fill out and s.gn forms onling, arretate POFs, convert graphic file types, batch edit
fies, password protect a PDR, highlight and trarslate text, and much more.

Ciudad de
México— de
Elena Llorente

Ex (+]

Fill in g PDF formn.
In Preview, click a fid d in the: form, then type your text. You can choose File > Export to save the form, open it later, and cortinue to fill itin

Bave: 4 PDF with a password.

To secure a PDF, gives ita password that users must erter besfore they can see the contents. In Praview, ofsen he PDF youl want 1o save with a password,
choose File > Export, then clide Permissions. Select Permisd ors optiors, and type apassword for Ow-er Password. Retype itto verify, clidc Apply, then
click Save.

Tip:
You can also enter a mew name for the PDF before saving to create a copy of the password -secLred PDF while keeing the original PDF unercryited.

Add and remove PDF pages.
Open a PDFin Prev ew and add, delete, or rearrange pages in the FDF

L]
Add 8 Dage:
Select the page you want 1o aoiear Defore e new page, choose Edit = Insert, then choose “Fage from File™ or *Blank Fage.” The rew page is inserted
after tra currert page.

Delete g page:
Choose View > Thumbnails or View > Cortact Sheet, select the page or pages to dd ete, ten press the Delete key on yoLr keylooard {or choose Edt =
Delete).

Move Dages:
Choose View > Thuminails or View » Cortact Sheet, ten drag the pages to thér new location.
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Copy a page frorm one PDF toarnother:
In each PDF, choose View = Thumionails or View > Cortact Steet, then drag thumisrail images from ore PDF to the other.

Translate ina snap.

Select the text you wart to translates, Control-dlick the selected text, choose Trandate, tren croose a language. You can aso downioad langLages so you
can work offine—goto the Language & Region settirgs in System Settings, tren click 1he Trarslation Languaces button at he bottom Not al lIanguages
are availale. See Translate on Mac

irmthe macOS User Guides.

View and convert image fifes.

Preview can corvert images to many file types holuding JPEG, JPEG 2000, FDF, PMNG, PSD, TIFF, and others. V¥th the image cpen inPraview, choose File
> Export, click the Format menus choose a file tyises 1woe a new rame and choose a Iocation for the fle, ten click Save. If you dont se& he option you
wart inthe Format menu, hold the Oiption key while you click the menu to view saed dized or older formats.

Tip:
To convertmare than one imags fie at atime, openthe files inone window, selectthem inthat window's sidear (ress Command-A to salect alll, then
follow e steps albove. Youcan dso batch resize image files by sd ectirg them all and choosing Tools > Adjust Size.

Ledrn more,
See the Preview User Guide

Reminders

Reminders makes it easier than ever 10 keap tradk of al of your to-dos Creats remirders for grocery |ists, projects at work, of ahything dse you wart to
track. Use flexibe tools like Tags and Custom Smart Liststo orgarize your remindars to match your workflow, and Save Reminders lists as iemplates 10
reuse them againin the future. You can alsoshare a list with others to cdldsorate and work together.

Add tags.
Add 1ags 10 Organize YOUr rEmMiNders. itk ONE OF More 1305 iN1he SidSbar 1 qui oy filte remindsrs.

Create Custom Smart Lists.
Smart Lists automatically sort your LBSoming reminders based ondates, times, tags, [osat ors, flags, o prionity. Creats Cusiom Smart Lists by dicking
Add List, select "Make into Smart List,” then add fiters.

Save alist as aternplate.
VWhen you Create 3 St that you want 10 relSE, YOU Can Save it as 3 t8Mp 38, Select the list in e Sigebar, then choose [ (& > Save as Tamplate

See what’s coming up.
The Today and Scheduled listsinthe S deba group items based ontine and date Keep ontos of upcoming remindgrs and make Sure you Never miss a
heat.

Use smart suggestions.
Reninders aLtomat cally SUGGEests dates, imes, and [oCatiors for A reminder Lased onSimila” reMind&'s yoU've Created in he past
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Smart Lists keep
reminders organized. Add a reminder. |

= Reminders 7
@ 0@ 16
Tocury Sohedulnd

Al Flagged

Complsted Family

Collaborate on a list.
You can send an nvitation o collaiZorate on a list in Messages or Mall, or share the link, Click ™,
ther choose Messages, Mail, o Invite with Link If you S-are in Messagas, everyoneg on the thread is aLtomatically added to te list Once vou've invited

others tojoin, you can frack activity a-d manage collaioration by clicking 42 .

Assign responsibility.
Assign reminders 1o peodle you share lists with, so that they receive a notification. Selt up tasks and make sure everyone krows what tey're respensible

for. To sharealist, click M
inthe menu bar and choose how to share.

Organize with subtasks and groups.
To turna remingder irtoa Sustask, Bress Command-]
, OF drag it on 103 of another remingér. The parertreminder BEComeEs bold, and the SUStask S indentéd urd emréath it Yod ©an collapse or expard yolr

Suiztasks to keep your view uncluttered.
To group remindears together, choosa File = Newy Grous. Name the group whatever you'd like. Add more lists by dragcing theminta he groups, of remove
them oy dragging thesm out.

See what you've cormpletec.
The: Comidleted Smart List in your sidekcar lets yousee all of your finished reminders, including when yvou checked them off.

Get rermninder suggestions in Mail.
When you'ts cotresgonding with someons in Mai, you can uss Siti 1orecogni 26 1SOSsibls reminders and make suggestions for you 1o creats them.

Add a reminder guickly.
Use natura language to quickly add a reminder. For example, wite ' Take Ay to soccer every Wednesday at SPM” 1o create arepeating reminder for that

day and time

Ask Siri.
Say something like: “Remind me to stop at the gocery store when | lgave here.”

Use the Touch Bar with your 13-inch MacBook Pro.
Use the Touch Bar in Reminders to add new items, check off completed iterns, f'ag an item, o add irfo, time, or ocation to a reminder.

g7
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Ledrn more,
Sae the RemindersUser Guide

@ Safari

Safari is the browser users |ove for its performarce, power efficiency, ard innovative privacy profections, like passkeys The tab bar, extersions, and start
page are available across Mac, iPhone, and iFad, so you get te same Safan everywhere you browse, aslong as you signin to iCloud with the same Agole
ID.

Start searching.
Start tysing a word or website address—3afan shows you matching wekbsites, as wdl as suggested websites. Or select a favorte or fregenty visited item
from your Safari start page. Vvhen you already have a site open, you can type your searchoriteriain the active tas iolauncha new search

Type what you're laoking for.

Favarites

Customize your Safari start page.

Your start pag & can show Favorites, Reading List items, a privacy report, and more. You can import apphoto of your ownto use as a background image, or
choose one of the provided kackgrounds. You can also share yolr start j5ages across devices. To set optiors for the start pages, click ==

inthe bottom right of the: start page

Use Start Page on All Devices

® s Favorites

) @ Frequently Visited
& 2 Shared with You
© Privacy Report

® & siri Suggestions
©o Reading List

# (3 Background Image

+ = 5( =
-~

View multiple webpages in one wintow.
Clide +
atthe farrightof the tab bar or press Command-T to open a new takb, then enter an address. Tabs resize dyramically as you charce the window size.
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Hold the peinter over a tab to
see a preview of the wabpage.

Caliznna

See tab cortents quicdy.
Favicons—i cons of |0gos associated with 3 welbsite—on taos (et you identify a welbpage at a glance. Hold the poirte over atab 1o 5ee a preview of the
webpage cortents.

View the sidebar

Clids the Sidedaricon (0

1o view the sideskar, where you can manage your Tab Grolos, kookmarks, Fead rg List, and Shared with You inks. You can also expand your Tab Groups
1o see dl your tass within a group by clidking v

nextto Tas Groups in the sideisar.

Organize with Tab Groups.

When you're doing research for a project or vacation, you can open several tals, 1hen save ard organize tiem in groups. YWhen the sidetsar £

is openy, click the Add Takbs Group icon &

and choose MNew Tab Group fo create a grou from the takos a ready open. O choose New Empty Tab Group and search for tabs to add to a Tab Grou-
The Tab Groups are saved and wisikde inthe sideloar. Switch etween Tab Groues using the sidekar or tre pop-up menu v

if e sidelzar is hidden.

Collaborate on Tab Groups.

Youl can send an nvitation to collabzorate on a Tab Grousin MiEBssages, and everyong on the thread is autcmat caly added tothe Tab Group. In the sdebar,
click @

nextto the Tab Group that you want o share, choose Share Taz Group, 1en dick Messages. Orce youlve shared a Tab Group, collaZoralors canadd heir
own tabs, and you can see what page others are currertly viewi ng when inthre Tab Group.

Note,
Talz Groups are available across devicesthat are logged irto iCloud with tre same Apple D, so you have access to your tabs from anywiere.

N A8
Portage Trip

u@» Fu@e

Filte Fyour browsing with Focus.
Set Tab GrOUDSiD 3 particular Focus 1o organizZe yo L browsing, FOr example, 5&oarate tabs you Lee for wore from others wou USE 0N A regular Easis
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Choose Apple Manu = System Settings, then dick Focusin the sidebar. Select a FooLs, like Worlk, on thefight, click ) ,
and choose Add Filter under Fcous Filters. To lean more alzolt addirg or cLstomizirg a Focls, see Set Lp a Focls on Mac

Protect your data with passkeys.

Fasskeys dlow you to signin to welbsites while keess ng ywou safe, ard use Toudh 1D or Face 1Dy, instead of a password. Passkeys work across non-Asple
devices as well. YWhen you use jpasskeys, they are saved in your iCloLd keydhain, ard because they keep you safe from pphishing and data leaks, theyre
gven safer than two-factor authertication.

To USE passkeys, you must haves Password & Keydhain tumed on in Cloud Settings. When you sign into a weksite, choose to save apasskeyfor that site
To signin, youdcan use Toluch ID or your iPhore or iPad. Teleanmore asolt setiing up and using masseys, see Signinto an account onyour Mac with a

passkey

Shared with You.

When friends in your Contacts share interesting artid es, recipes, and other lirks with youin Messages, they automaticaly apppea inthe Shared with You
section onthe Safan stant page and in the sidebar. Stories found in both Safan and MNews assear in the sidebars of both apps, so youcan read them wrere
it’s most corveniert.

Discover extensions.

Extensions add functionality to Safari to personadize your browsirg expoenence. You can fird extens ors that Hock ads, find coupons, fix your granmmar,
and quickly save comtent from your favorite websites Croose Safar = Safan Extersionsto view tre extensions category inthe App Store

. which features spotlighted Safar extensions and categories (Browse Better, Read with Ease, Top Free Appps, and S0 or), After you get extersions, fun
them on in Safan settings. Szlect the Extansions tab, then dick checkboxes to turmon extensiors.

Mike NOLES ON a webpage.

Highigrtand make notes directy ona webpage with Quick Note, so your notes will be saved for the next time you visit. Click he Srare button
for the webpage and choose Add Chuick Note. Open and view saved quide notes from the Notes

s detar or return o the webisaces and lap the thumonall of the: saved rote to open

Browse the web safely and privately.

Safari autornati cally upgrades the sites you visitto HTTPS, and warrs youwhen you visit awebsite that’s not secure, or that may ke trying to tick you into
sharing your personal data 1 also protcts you from oross-site tradking, by i dentifying and remnoving the data that trackers leave behird. Safan asks your
permission before |etting a socid Network see what you're doing on thirc-party Stes. And Safai defends you acainst web tracking by making your Mac
Farder toidentify. Intelligert Tracking Prevertion preverts frackers from profiing you Lsing your IP address

Hide your email address.

With an iCloud+ subscristion, you can create a unigue, rardom email address any ime you need ore {for examoe, when ccmp eting a fom on a wekssite),
with No limit to the nuMiser of addressses you can Lse VWhenyou oeate aHide My Emal address for a site, ary emal sent to that address gets forwaded
o your persoral email accourt. You can receive emall witrout havirg to share your actual emnail address, and you can dsadl e a Hoe WMy Email address at
arytime. See Create unigues, random email addresses with Hides My Emnail iniCloud+
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View @ privacy report.

To bsetter understand how asite freats vour privacy, cli ck the Privacy Report button©

tothe left of the active fab to view the cross-site Trackers that Safari is blocking on each website, Clids (0
103 568 a privacy report with More detal sakcout 16 webSte'sactive trackas.

Translate webpages.

You can instantly translate enfire webgages in Safari. YWhen yol encounter apace that Safari can trarslats, you see a trandate button G
inthe welbsite address field. Click fo translate between languages. THe bution changes color %

to show when awelyzage has lseen translated.

MNate:
Transiation fegtures are Not availad eimall regions or ANcLAges. You can fird a list of available languages at Safari: Web Fage Trarslation

Tip:
I awebpage, force dick 2 word 10 see its definiion, o aVWikiped a articl gif ong is ava laale. Try force clidking text in other apps, like Messaces or Mail, 1o
get more info.

Use the Touch Bar with your 13-inch MacBook Pro,
Tazthe left or igk-t arrow button inthe Touch Bar to go backward or forward Tao
1o open a new tab.

Tap the tals scrubber in the Touch Bar to move between open tabs.

ITab scrubber

Tap the Search field Q
inthe Touch Bar, then tap a favorite fo openit. Vren youfinish, tap &
1o returm to the Touch Bar you started with.

Customizethe Toucth Bar t0 add your favOnte cortrol 5 (chooss View = CLstomiZe TolCh Ear),

v s A i e 0 1 e e 1 P

Sa=e Customize the Touch Barom the 13-imch MacBook Pro

Learn more,
See the Safar User Guice

) shortcuts

The: Shortcuis app lets you gquickly perform mult -step tasks with just a click o by activating Sir. Create shortouts to get directions to the next event in your
Cadendar, move text from one app toanother, and more. Choose: ready-made shortauts from the Storcuts Gallery or build your own using different aoos to
un mutple steps in a taske.
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Wiew and organize Click to show View collections

your shartcuts in or hide the of ready-made
\the sidebar, sidehar, shortouts,

| |

- - { aQ

Sharteuts for macos Siri Games

Gt ST Done

Agaliery of possibilities.

Browse: or search for shortouts in the Gallery. Starter shortcuts are availabsle for a range of conmnon tasks grouped in collections. The shordcLts you aoeate,
and any ready-made shortculs you choose or edit, are shown in WMy Shortcutsin the Gallery S celsar. To Show or hide the Gallery sidebar, click he Sidekar
button (.

Build custorn shorteuts.

Create anaw shattolt, then dreg actions from theliston thesright to t& shortout editor on thel eft to produce the result you want, Actons arg the buldirg
blocks of @ shortcLt, like StEos in a task. Choose from a wide range of actiors, such as getting the latest Pholo from the Photos aop, creatinga folder, o
copying the current URL from Safari. You can alsouse actions that run a script, s.ch as rounding anumizer, setting arplane mode, and doing calcuations.
Shortclts also provides “nextaction” suggestions 1o help you complete yolr shorclt.

Choose actions

Shortcuts are built Click ta run in the Action
with a series of actions. the sharteut, | |Lihrary.
e Make GIE O = =
i a
&) Receive Any input from Quick Actions and What's On Screen
Categorias i
Ask For @ Phates
= AD Actions s Suggestions
£ Beripting Fanvorftns
B was oir tram £ : ‘s
o Device Sharing
Seconds Per Phote: 005 5 7 Medis N Docimen iy
< Locstion 7 Ve
Loop Fesewer: @ - !
Aule Scer @)
@ Ovoray mage
2 Show BOIF B Cropin
B Cnoose Fram Mamu
B Stop ane output WOIF Text
L ey R 61 L Daicta Fln
Do Matting @ Share
B Create Mew Contact
B Flay Muskc
T Add How Event
@ FaceTire
Shorteuts to your shorteuls.

Using Sin torun a shortcut is e quickest way fo get something dore, You canalso add shortcuts to the Dods, the meru ban ard the Services menu of
apps. Double-click a shortout, dick Srortout Details =,
thEm ChOosE CBtions Under LUSE as Cuick action

O ask Sini.
Say something likes “Text last imags.”

Syne and share shortouts.
Sign in 1o all your devices with the same &ope ID
and your shortouts agpear on al of them. Edits you maks on one device are automatically reflected on your otter devicss. You can also share your
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shorteuts with others and recave shared shortcuts from Someone else. To share, douzle-click the shortoLt, dige dh,
themn choose how you wart 10 share it. Yol cam also add shortouts 10 run common actions to the Share Sreet in e sidesar.

Learn more.
See the Shorcuts User Gude

@ stocks

Thes Stocks appis the bast way 1o tragk the market on your Mac. View prices in ke custom watchlist, click a stock 1o see more details ard an interactive
chart, and read aboLt what's driving tre market, with Stories from Apple News.

Click to read the latest
business news.

e Top Stories

My Symialy

T dones 3487636
B4R EDD 43185
e wer i
" e g
o 10334 Wihat's It Like Working & Mare Homes Than Ever Are
) Four-Day Workweak? Selling for 550 Million.
What's Inside?
= Errey
L - 107 64
[ eu]
s ¥
™ 17315 4 Fuman Wt Dt
" ] Stanas n sk arets
smix 188 lw
Note.”

Aople News stories and Top Stories are avalable in the U.S., Canada, the UK and Austral a. News stores in other countries a-d regiors are provided by
Yahoo.

Create and custornize your watchlists.

Tn add a watchlist, c ck My Symibols, then New Watchlist To add a stock 1o a watcHist, enter a company name or stock symiol in the Search figld. In the
search results, double-click the stock symbol fo view stock information To add the stock to a watchlist, cick the +

inthe top-ight comer, then choose the watchlist that you would like the stocic to appear ine To remove a siock, Contol-dick the siock symbol and thoose

“Manage Symisol™. then deselect the checkiox from the watchlist youwou d like 1o remove it from. You can dso Cortrol-click a stock in your watdilistio
opzen itin a new tald or window.

Checlk market changes.

WVhile viewing your watchlist, click the green or red button ioelow each pri ces to cycle among Erice dhange, percentace change, and market caoitalization.
Thes watchiist also includes color-coded sparklines that Track performance throughout the day.

Read articles related to the companies you follow.
Clide astock in your watchlist to see an interactive ci-art and additional details, and read the latest news alboLt that company. Click Busiress Mews at the
top of the watchlist o see a collecti on of timely business articles, curated by Aod e News.

MacBook Pro Essentizls 103



Click to cycle between price
change, percentage change,
and market capitalization

SBUX wzar
Dosw Jones 31,004.90 hALDAL LD
1o 1w ™ w au Yo 1w ¥ L oy AL
AP GO0 3858 ET
[ B
L - 12821 o)
0E 07 o 24
=
i
301 50
L ® 1 12 1 z *
» 125,08 *
= o i Ao e | e 1
a —— e man | b uas
HEE 11142 Low B0 WeCap ELET LTE) BOHM  IFS an
..... )
EIY BEET
L — [ 55 5 = -
nibeasns Juw Hada ¥ Mebisnes vi.
bt -5:1;5 Cerparata Gasirance g Startneks| Which
Mtz Vour Baare STl Awntmurast Slock by . -
Sheuda Take Hite iif ! Betnar Bay? . o
Get a deeper view.

Wartto 52 what the market was doing [ast week, last moth, or [ast year? Clids the buttons above the chart 1o switch timeframeas and see orices in the
Wi By YO like best

Your walchlist on all your devices.
Keas your watchlist consistent across all your devi CEs wihen you 5gn in with the same Aople ID

Tip:
For aquick Iook at tre stock market, check the Stocks wid get i n Motificat on Certer
on your Mac.

Learn more.
Sae the Stocks User Guide

D v

Watch all your movies and TV shows inthe 4eole TV aon Buy o rert movies and TV shows, subsTing 1o charngls, and pide up where you left off
watching fromary of your devices.

Get started with Watch Now.
In Watch Now, browse a curated feed of recommendations, based on channd s you're subsariped 1o and movies or TV shows vou've watched

f

Btream Lickonthz Appl: T app 2

Keep watchingd in Up Next.
In U Mext, youll find movies o TV shows yollre watching, as well as movies and TV shows yoU've added 1o your gueue To add a new movie or TV show
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to Up Next, click the Add to Up Next bution.

Discover more in Mowies, TV Shows, and Kids.
If yolsre looking Tor something specific, dick the Movies, TV Shows, or Kids tab inthe menu bar, tren browse by gerre

Buy, rent, or subscribe.
When you find a movie or TV show you want 1o watch, you can choose tobuy orrent it. Channels you ve suksscrilsed to are availatble onall devices, and
can be used oy up o six family memibers through Family Sharing.

See what your friends are sharing.

When your friends and family use the Messages asio to share shows ard movies with you, you can watdh them wien it's conveniert for you. Just look for
them in the Agidle TV apip—in a new sectionin Y¥atch Now, called Stared Vifith You. Content orly apppears in Shared with You if the person who sent it isin
your Contacts. See hew features on your MacBook Pro

Watch together.

Conmect with your fiends using FaceTime, then use SharePlay 1o watcha TV skow or film with friends ard family—and even skare comments in Messages
while you're watching. To start watching, moves thes pairter over ary item in the TV ajgo, tren dick the Flay button. You can watch cortent on your Mac

whi e chatting with fiends on your iPhone. And with snart volume, audio is adjusted automaticaly 50 you canhear eadh other even during loud soenes.
See FaceTime

and Share expen erces with SharePlay

Note”
To use ShareP ay, you must have macOS version 12,3 or later on your Mac, and iPadOSs 1524 or lates on your iP ad. Some apps that sugoort SharePay
regulire A SUBSCHBHoN 10 participate. Not all featrés and cortertare avalaibiE2in all Countries or reg ons.

Choose something frorn your own library.
Clide Library 0 see dl e movies and TV shows you've purchased o downioaded, orgarized by gerre To start watching, just click tre movie or TV show.

Use the Touch Bar wath your 13-inch MacBook Pro.
Use the Touch Bar to rewind. pause, or fast-forwad what's gaying There’s also a soubbe bar for navigati rg within a TV showy ormovie and a sulcliies
puttan.

Ledrn mMore,
See the Apple TV App User Guide

Subsaripl ko et e karfpph V-

@@ voice Memos

Voice Memos makes it easiar than ever to capture personal remirders, class lectures, and evenintsry ews or songiceas. With iCloud, you can access the
YOI CE MEMOS yoll record with your iPhone, right on your MacBook Pro.
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00:16.11

Record from your MacBoolk Pro.

Clige the Record button @

1o start recording, then click Dome to stop. Yod can rename a recording to make it easier o idertify. Qick he default name, then erter a rew rame. To day
baCk your recording, click the Play bbutton b,

Your voice mernos across all your devices.
Your vOiCE MEMOS are availaible on al your devices when you 5 gnin with the same Apple D
. Yol Can access recordings yold made with your iPnone oriPad right from your Mac

Organize with folders.

Create folders to help you keep your Voice Memos organized. To add a folder, dick the & debar buttom L,
thenclick the Mew Folder bLtton at the: bottomn of the sidébar Enter a name for the fol der, tren click Save. To add a recordirg to tre fo der, press and hold
the Option key while you drag the recording to the fal der.

Mark recordings as Favorites.

00:57.66

| ]

Create new folders to
organize your recordings.

Mark a recording as a favorite.

Seslect a recording, then click tre Favorite loutton ©

iNthe toolkar 50 you can quickly find the recording |ater. Qick the S debar button B
10 see all your Tavorites.

Skip silence.
Skiz over gaps inyour audio. Click the Playback Settings button at the fop of the Voice Memos window ad 1urn on Skip Slence.

Change the dayback speed.
Speed up of slovy down your audice Click the Playiback Settings utton at thes top of 1he Voi ce MeEmos window, then drag the slider 1&ft or gt
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Enharice a recording.
Inizrove the sound quality of your Voice Memos by reducing sackground noise a-d room revereration. Click the Playback Setlirgs button at the top of tre
Voice Memnos window and turn on Enrance Recordirg.

Use the Touch Bar with your 13-inch MacBook Pro.
Use the ToLch Bar 10 record, pause, Or [ ay your voice memo.

Learn more.
See the Vdce Memos User Guide

Find answers

Use the macOS User Guide
Thes macOS User Guids has alot more infomaticn about how 1o Use your MacBoos Pro.

Get help.

Clids the Finder icon &

inthe Dock, then dick the Help menuin the menu ba- ard dhoose macOS He p to open the macOS User Guide. Or type a question or term in e search
field, ten choose a topic from the results list.

ese [ macOS5 User Guide M Q

> macOS User Guide

\&7' 5

Show the table
of contents,

Get started with your Mac Learn about
macOS.

You can set up and start using your new Mac in no time.
Choose a look for your desktop, change comman settings,
start using apps, and more,

Learn how to-get the most from your Mac »

Explore topics.
To find a topicin #he macOS User Guide, you can browse or search. To browse click “Talle of Corterts” to see the list of fopics: tren dlick atosic toread
it Or tyjoe what you want to find in the search field to goright to your answer.
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Click » to view more topics.

ese M < macOS User Guide h a
Welcomea
< Gat to know tho desktop n Use Siri on Mac
What's in the ;
menu bar? You can use Siri on your Mae to do everyday tasks |ike

setting up & mesting, opening an app, or getting quick
Wokory e op AnNSwWers to questions,
Search with Spotlight s 3 5
: Click to closs Click tha Siri icon,

Quickly change settings (thie Siri windav. then make a request.

Get notifications

Open apps from
the Dock

Drganize your files

‘Click a topic to read ft.

Find out what's new.
Cligk thes Help menu, then choose “Ses What's New in macOSe tofind oLt more about the 1atest features of macOS.

O Tip:

If you can’t remmember the location of a menu iternin an aop, search for it in Help. Place the poirter over the result, and an arrow sows you the command.

it ol | checkiak

) Wiribe and formar nates on Mac-
(&) Add ints. in Notes an Mac
1 Chinge seitings in Nals an Mac
] it 2 g0

Learn more.
See the macOS User Guide

Are you new to Mac?

If thisis your first Mac computer, here is some Felpfal irformation to get you up to sseed —espedally if you came from a Wirdows ervirormert

Familiarize yourself with the deskiop,
Thes deskiop is where you do your work, and where you can gui clkdy osen aoss, search, ard organize files.
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(Apple menu Finder window

o e weos e

(App menu Help menu Meru bar S;:‘u!light1

i

System Settings Dock

On the deskiop you'll find:

The mendt bar:
The meru bbar for the deskiop or the active osen aop s always at the top of the screen Use merus tofind optiors ard perform tasks in apps For
irformation about items in the menu bar, such 8s tre Agde menu and the Help meny, see Deskiop, menu bar, and Help on your Mac

The Dack:

The Dock issimilar to the: taskizar and Start menuin Wirdows ard appears at the bottom of the desktop fout you canchange its lccatonin System
Setings

) The Dock makesit easy to see dl the apps you have openand auickly | aunch your Tavonte aoos. To openan aoe, click its icon in the Dock, Yeu can
als0 open 33108 UsIng Launchpad

. See The Dock on your Mac

The Finder:

Click &

inthe Dock o open the Finder, where you organize ard locate your fies (similar to Fle Exd orer inWindows). Use the buttons at tre Top of the Finder
window 1o change: how you view your fles—as icors B8,

inalist:=,

incoiumns [0,

orinagallery .

In any view, you can select a file and press the Space bar to see a Quick Look preview without opening the file. See Finder on your Mac

The Spotlight meru

Spotligh-t lets you search for anything on your WMag ircluding documerts, contacts, e1ail messages, and mores You can also launch apss ard search
on the web. To open SpotligH, click the Spotlight icon &

atthe top right of the screen or press Commard-Space bar. See Saotlight on your Mac

Systern Settings.

Systemn Settings &

issimilar to the Cortrol Fanel in Windows. Customize your Mac with settings for the deskiop, Doclk, display, Bluetoothy, metwork, and much more, See
Systemn Settings on your Mac
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Get 1o know the keyboard and trackpad.

The: Command key 35

on Mac is generaly the same as the Control key on VWindows For examd e use Command-C and Command-V to copy and paste contert, The Retorn key
on Mac i5 he sane asthe Erear key on Vindows, while he D et key isthe same as Badkspacs, i you want to forward delets, Press Fn-Déeta

Use the trackpad to dick, right-Click,, force click, scroll, Swipe, ard resize documents qui Ckly, See MacBook Pro trackpad
for details on trackpad gestures.

For alist of Mac keyizoard shortcuts and differences between Mac ard VWindows keyisoards, see the Apple Supizort article Mac fips for VWindows switchers
. Also see VWindows Keys on alac keyboard
inthe macOS User Guide. For more shorcuts inthis guidey, see Keyboard storcuts onyou Mac

Install apps.

You can downipad apps from the App Store or the interret. VWen you download anae fromthe imtemet, vou get a disk image file (ending in .dmg) or
package file {.pkg). To instal the app, locate the .dmgor .geg file in your Downloads folder, dould e-di de it, then follow the onscreen instrictions. You're
promicted to celete the disk image or package file after you instdl 4 agz.

To unirstal an apo, find the apo in the Apslications folder in Frder, then drag the agos to the Trash, Some apps have an Uninstaller, which you canwse to

dalete the app and other files associated with it See Install and unirstal apps
inthe macOS User Guide.

Maxirmze, minimize, and close windows,
You can have multiple windows for an apis open at atimes Use tre buttors inthe tozdeft camer of a wirdow to resize and d ose windows.

o Click the Close Window button @
or press Command-V¥ to dose the window, but not the asia Press Optior-Command-WY to close all open wirdows for the appe. Press Command-GHo

quit the apis

e Click the Minimize Window Button =
to minimize a window (or press Cormmand-hl. Minimizing a window [eaves the app open bLtreduces the wirdow 1o an icon on the fig-t side of the
Dock, Click tre icon 1o restore the window to its pravious 5ze.

o (Click the Full-Screen Windcw button &
to open your aop full-screen. To maximizes the window, ho d #& Opstion key and clids the button. Or Fover onthe button to se& more opticns, such as
1iling the window. Press Esc to return the wind ow toits previous size.

Mowve Windows,
Drag te window by its tile bar to put it where you wartit. Some windows can't be moved Ses Manage windows on Mac
imthe mac O3S User Guide.

Switch between app windows.

Press Command-Taz to guickly switch to the previous azp VWhen you have several app windows apen, pressand cld Command, tren press Tab to see
icons for all the open apps. While holding Commiard, press Tabe (or the arvow keys) to move Between the apps ard select e one youwart fo be aclive
Release the Command key to work in the active app.

Take a screenshot.
Press Commanrd-Shift-5 to access the Screemnshot Ulility. See Take a saeenstoton your Mac

Let Siri do tasks for you.
To activate Sin onyour 14-inch or 16-inch MacBook Pro, click the S icon at the Top right of e screen or press thes Dictation/Siri key (FE). Cn your 134mch
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MacBook Pro, you can tap the Siri kutton in the Cortrol Strip onthe Tolch Bar or press and hold Commard -Space bar. If e option is tured on you can
say "Hey Sin™ and continue with your request. Ask Siri to opena folder, laurch an app, make the screen krig-ter, and other fasks. See Siv on your Mac

Use your Mac with iPhone, iPad, and Apple Walch.

f yousignin to your Apiple dev ces wilh the same Agple ID

, you can easily share files and pphotos, edit doouments, answer email and cdls, and send text amorg devices See Use your MacBook Pro withiCloud and
Cortinuity

Learn more.
See the Appie Support arlicies What's itcaled on my Mac?
and Mac keyizoard shortouts

Common questions about your Mac

How do | get support for ry MacBook Pro?
Go to MacBook Pro Sugzort

Prm new 1o Mac. Are there tips for PC users?

Yes! See Ave you new to Mac?

and the Appie Support articke Mac tps for Windows switch-ers

. You migtt also be interested im Keyboard shortouts onyourMac

How do | take a screenshot on my Mac?
Press Commard-Shift-3 to take a screenshot of the ertire screen. Press Conmard-Shift-4 to take a screenshot of a selected area of the screzn. To learm
more, see Take a screenshot on your Mac

Where is rmy senial number?
Choose Apple meru &
> Apout This Mac Theserial numer is listed. Youcan aso fimd the sefial numiser on the botiomn of your MacBook Fro.

How do | know which rmodel of MacBook Pro Lhave 7

Sae the Appie Support articl & Identify your MacBook Pro mode
. You can A8 chooss Aspde menu @

= About This Mac to view the model information.

How can Ifind the documentation for my MacBook Pro?

To find the MacBook Pra Essentials

guide, open System Settings, clide the Help meny, then click User Manual. Fom te Help meny, you can also click *macOS Help” to open the Lserguide
for the operating system. For older Mac models, ses Browse manuals by product

How do | get help for an app?
When you're using e apxo, click the Help menu in the menu ba- at the top of the screen
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Where is the safety information for my MacBook Pro?
See Impottartsafety irformation for your Mac

How do | find the technical specifications?

Go to 13-inch MacBook Pro Tech Specs

, of 14-inch and 16-inch MacBook Pro Tech Sipecs

, OF open Systemn Settings, click Help, then dick MacBook Pro Szecificati ors.

How do | check my disk for problerns?
Use Disk Utility. See Repair a storage device in Diglk Utility on Mac
inthe Disk Utility User Guide.

How do I reinstall macOS7?
Use macOS Recovery. (The macOS Recovery process for MacBook Pro with Asle silicon is different than tre process for oiher MacBook Pro mocels)
Ses How to reinstal macOos

Maote.”
Beginning with macOS Big Sur, Time Machine badkuss don'tindude system files. See Back up ard restore your Mac

What should | do before sedling or trading in my Mac?
Back Lp your data, then restore your Mac to factory settings See YWhat to dobefore you sdl, gve away, or trade in your Mac

Keyboard shortcuts on your Mac

Yold Can Press key COMG Nations 1o do things on your MacBook Pra hat you'd normally do with a trackpad, mouss, of other device, Hers's alist of
commorly Lsed keyiroard storsLts.

Maote,

Keytoard shortcuts in asps may vary depending on thelanguage and keyboard layout you're using on your Mac. i e shortcuts below don't work asyou
expect, ook in the asp menus in the menu bar 1o see the corect shortcuts You can also use the keyboard viewer 1oseég your cunert keyboard layout,
known as an input sources See Use the keyboad viewer on Wac

imthe macOS User Guides
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Shortcut Descripion

Command=x Cut e selected itemand copy it to the Clipkcard.

Cormmand-C Copy the selected ilem o the Clipbcard.

Cormmand=y Pastethe conlents of the Clipkoard intothe currert dooument or apn.

Command=2 Undo the preyi CUS conmand, Press Command=Shift=2 to redo,

Cermmand=A Select dl items

Cermmand=-F Open a Find window, o find itemsin a docLment.

Command-G Find the next cocurrence of the temyoLrre searching for, Press Commeand-Srift-G 1o find the previols
DCOrence

Command-H Hicle the windows: of the front 2op. Press Command-Option-H to view the front oo but hide all other apps.

Cemmands=i Mini rrize the front wi rdcw to the Dock. Press CommandsOpticns=i to minimize all wirdows cf e frort spo.

Cormmand=h Cren a new decument or window.

Command=0 Cren the seecteditem, or gpen a disloeg to sd ect a file to open.

Command-P Prirt the current document.

Command=S Save the curent document.

Command-w Clesathefrontwindcw. Press Command-Opticn-wio close allwindows of the aop.

Cormmand=0 CLitthe currert app.

Command-Ortion-ESC ChCOSe an app o Fore e QLit

Cermmand-Tab Switch to the next most recently used app among your open apps.

Command=Shiftes Cpen thie Screenshiot Lt ity. Yoll cAn S0 take SCreenghicts LS the following ShorcLS:

o Fress Commande=Shifts3 to take a screenshct of the ertire screen,
o Fress Command=Shiftsd to take a screenshct of a selected area cfthe sorean.
¢ Fress Command=Shift=5to cacturete Touch Bar cn tre 13=inch MiacEook Fro.

FOr MCre kEyboard ShortCuts, S88 1he ApDe SUBDor article MAc keyizoard shoricuts

Security features for MacBook Pro

Your MacBook Pro with Apidle silicon provides seourity features to protect what's on your comiuter and prevert unacthorized software agos from lcading
during startus:

Secure startup:
Support for secure startup is turned on automatically. It's desigred to verify that the operating system software [oaded onyour comguter at startupis
authorized by Apple.

If your MacBook Pro doesn't start ecause it detects an unfrusted component, it starts up from a secure recovery partition and autormalicaly corrects
issues if possikde. To leam how to set security optiors, see Change security settings on thes startup disk of a Mac with Asde slicon
inthe macOS User Guids.

Secure storage:
Your M3acBook Prostorage drive is encrypted with hardware keys 10 provide advarced levals of secunity. Inthe evert of a catastrophic failurg, data

recovery may Hot be possid & 50 you need 1o back U vour files 1o an extemal source. Sea Use macOS Recovery on a Mac withApols silicon
inthe macOS User Guice.
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Yol can set L Time Maching or another sackup plan to regulary pack Lo your files Sees Back up yvour fles with Time Machine
inthe macOS User Glide, and the Apple Susport arti cle Back Uo you Mac with Time Maching

Systerm integrity:

The Apple silicon in your MacBook Provis designed to verify that the wersion of macOS software loaded during startupis acthorized by Apoie, and
cortinues behind the: scenes to protect thes act-orizations estakd ished for macOS. This makes it harder for ma ware or malici oLs welbstes to expoit
yolr Mac.

Data Protection:

In additionto the default storage drive encryption in MacBook Pro, third-isarty ams develogers can use filedeved ercryslion to better protect sensitive
data, without impacti ng system perfornance.

Carnect accessories seclirely:
With aMacBook Pro with Azple silicon, you can approve new USB and Thundertolt accessor es when you connectthem to your MacBook Pro. See
Allow accessories to connect fo your Mac

Note:

Inrare circumstances, such as a power falure duting a macOS Lpgrade, your MacBook Pro may Become unresponsive and the firnware on tre chip may
reed to be revived. See Fevive or restore a Mac with Aople silicon with Apple Configurator

inthe Apple Configurator User Guide.

Learn more.
See the Apple Platform Security User Guide

Save space on your MacBook Pro

Vith Optimize Storage, You Can avtomaticaly fre€ WS SHace on your MacBook Pro kY making fies availade on demand, Yo, Oidest fles will be Stored in
iCloud and on your ermail IMAP or Exchange server, so you can download trem at any tme. There are also tools to idertfy and delete bigfiles.

Ontimize storage.
To 5&6 storage recommendations, go to Asdle menu @
= System Settings, then click General on the side bar. Clide Storage: on the right to see differert recommendati ors pased on howy you configured your Mac.

80 { Storage
B Macintosh HO 458 Gl of 488 38 GF

L3 wottications .

&l sound

Recommendations

g 5tore in Cloud Stare in (Cload.

u Optiemize storage Optimize...

Empiy Trash automatically Turr OF...

B Deekton & Dock
Set options 1o

L]
Store in iCloud:
Store dl files, photos, and messages in iCloud ard save space on your Mac.
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Deskiop and Focuments:
Store all the files from your Desktop and Documesrts folders in iCloud Drive. Ywhen storage space is needed, iCloud Drive keeps recertly opened
files on yoeur Mac and makes your oldest fies avalable on demand.

Messages.
Store all messagesand attachmentsiniCloud. VWhen storage space is needed, i oud kegos recert atiachmerts on your Mac and makes your
oldest files availazle on demand.

Even though your fles are stored in the doud, you can access themn right where you left thermn on your MacBcok Pro. See Access your iCloud contert
on your Mac

Optimize storage:
Save space on your Wac by optimiZing the storace of movies and TV showsinthe Apple TV app. You can choose toautomaticaly remove movies or
TV shows from your MacBook Proafter you watch them. You candownload them again at any time.

Empty Trash automatically:
Automaticaly erase items that haves been in ke Trash for more than 30 days.

To heliz you save space as you wonk, macOS also:
¢ Preverts you from downloading the same file twi ce from Safar
e flerts youto remove installer software when you finish instalinga new asp

¢ Clearslogs and caches that are safe to remove when you're low on storage

Learn more.
See Optimize storage space on your Mac
inthe macOS User Guide.

Take a screenshot on your Mac

Explore the Scresnshot menutofind dl the controls you nesd 10t SCreenshots and SCrean recordings. You €3N alse capture yols voiCe doring a screen
recording. The optimi 2ed workfiow lets you take photos and videos of your seresn, and then easiy share, edit, or save tem

Access the screenshot controls.
Press Command-Shift-5. Yo £aN catilure the ertire SCreen, A SEIECtEd Wind Ow, OF A POrtioN Of 3 WiNdow, YollCan alkD reCord 1 entire SCre=n or a
selected porion of e scresn.

Use the icons at the izottom of the screen to capture a selection !,

record Your screen &= ,

and more Click Oistions to miodify your save |ocation, set aimer before casturing, set microphone and audio opt ors, or g-ow the peinter. Click Capture
or Record 1o take the screemshot or video.

After youtake a screenshot or video, a thumibbnall asiaears in the corner of he screen, Drag the thmbnail into a document or fd cer, swipe to the rightto
QUICklY Save it, Or CliCk O edit OF shae it

Note:
You can also open the Screenshiot Liility from the Gt folder in Launct-ad
, O go to the Aoios = Utilities folder in the Finder.

Mark up your screenshot,
Cli e thes thunniznail of your Scregnshot 1o Lse MarkLi 100!s and make annotations. Yol can aiso ol ck Share
1o send your marked-uUp screen to colleagues or fierds—rigt from thes screenshotitse . See Mark up files on Mac
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inthe macOS User Guide.
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Learn more.
See Take screenshots or screen recordings on Mac
inthe macOS User Guide.

Mac resources, service, and support
Youl can find more irfommation about your MacBook Pro in System Rasort, in Apisl @ Diggnostics, and throlGh onling resourcas.

Bystern Report.

To get infomation akout your MacBoolk; Pro, wse Systan Report, It S-ows you what hardware and software is inslalled, the serial numcer and operating
system version, how much memory is installed, ard more. To open System Report, c-oose Aosle meny @

= About This Mag, then click More Info. Then, click System Report

Apple Diagnostics.

Youl can uses Agple Diagnostics To help determine if there's a problem with ore of the comiauter’s comisoner-ts, such as he memory or processor. Aople
Diagnostics halps to identify the potertial source of 2 hardwarg issue and providas first stess 1o try and resdveit Apple Diagnostics will 3lso help you get
intouch with ApsleCare Sugport if you reed more Felp.

Before using Apple Diagnostics, disconnect ary extemal devices, such asahard d sk or extermal display. Be sure the MacBook Pro is connected to the
irtemet.

To start Apile Diag nostics cn MacBook Pro with A55le silicon, restart thes computer, press and hold the power bution for 10 secord s to open Startup
Options, then held Command-D to enter Diagnostics mode. To start Aggsle Diagrostics on other MacBook Pro modd s, restart the computer and hold down
the D key asit startsup.

I promigted, sdect the language for your location. Press the Feturn kay or click g rght arow button The basic Apple Diagnostics test takes a fow
minutes to complete. K anissue is found, a description of the issue appears with addtional instructions. Make a note of any reference codes before you
exit Apple Diagnostics, in case you need 1o contact AgpleCare susport

Online resources.

For onlime service and support information, go to Welcome to Apple Support

« You can leam about Apple products, wiew onling manuals check for software updates, connect with other Apple userss and get services supcort ard
professional advice from Apole For more information about your MacBook Pro, Go 1o MacBook Pro Support

AppleCare support,
If you reed assistance, AppleCare representatives can help youwith installing and opening apss., and with troudeshooting. Call the support center numoer
rearest you (the first 80 days are comalimantary). Have th& jpurchase date ard your MacBook Proserid numbegr ready wi-en you call.

A complete list of susport telephore numicers is avalable onthe web at Cortact Apple for support and service
. Telephone numizers are subject 1o change, ad Iocal ad national teleshore rates may apply.
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Your 90 days of compdimertary telepshone supgport Begins on the: date of purchase

Safety, handling, and regulatory information

Important safety information for your Mac

£ WARNING:
Failure to follow these safety instructions could resut imfirg, electric shock, or other injuries, or damace to your MacBook Pro, cables, o other property.
Fead al safety irformation bselow izefore Lsing your MacBook Pro.

Built-in battery.

Dorftattermpt to replace or remove the battery yoursdf—youmay damage the battery, which colld cause overheatirgand injury. The built-in battery
should only be replaced or repaired by a trained fechnician 1o avo d satiery damage, which could cause overheating, fire, or injury. Regairs performed by
Lrtrained individuals of Using Non-genuine Asple parts may affect the safety ard functiond ity of the device. The buil-in battsry must be recyded or
digsosed of separately from household waste. Dispose of batleres according to your loca ervirormertd laws ard guidelines. Dot exjsose your MacBook,
Proto extreme heat sources, such as radiators or fireplaces, where temperatures might exceed 2H2F (100°C),

For information asout battery serv ce and recycling, go to Battery Service ard Recyclirg

Handling.

Handles your MacBook Pro with care. it is made of metal; glass, and plastic and has sersitive glgctroni c componeartsinside Place your MacBook Proona
staldle work suface thatalows for adeguate air dreulation under ard around the computer. Your MacBook Fro can e damaged if dropped, buned,
punctured, or crushed, or if it comes in cortact with liguds, oils, and Iotions, Dot use a damaced MacBook Pro, such as one with a oracked screen, as it
may Cause irjury.

Handle your USB-C 1o MagSafe 3 Cable with care. It cortars sensitive electroni c components irside, Charge your device on a stable work surface that
allows for adeguate air d reulation under and around the: computer. Your USB-C o MagSafe 3 Cable can kbe damaged if droppeds burred, punctured or
crushed, of if it comes in contact with liguids, Gils and lotiors. Don't ULse a damaged or frayed USB-C to MacSafe 3 Cable.

Liguid exposure,
Keep your MacBook Pro and its charge: cable away from s5ources of liquid, such as drinks, oils, lotiors, Sinks, batt-tubs, shower stalls, and so on. Protect
wour MacBook Pro and the charge caizle from dampness, Humidity, or wet weather, such asrain, srow, ard fog

Charging your MacBook Pro.

Charge your 14-inch or 16-inch MacBook Pro orly with e included 67w USB-C Fower Adapter, 86V USB-C Power Adapten, o 140 USB-C Fower
Adapster and USB-C toMagSafe 3 Caldle, or with a third 4oarty powesr adaister and cable that are compatible with USB-C PD and compliant with applicasle
irternational and regonal regulatiors and safety standards. Charge your 13- rdh MadBook Pro only withthe induded 87W USB-C Fower Adaster and
USB-C Chiarge Cable, or with a third-party power adapter and cald e that are compatiible with USE-C FD, and comdiart with applicalde irternational and
regiona regul ations and safety standards.

Cther pover adaters might not meset applicalle safety standards, and charging with sLch power adapters could pose a rigk of death or irjury. Using
damaged power adaglers or caBles, or dharging when moa sture is present, can cause fire, glectic shock, injury, or damage to your MacBoodk Pro or otrer
property. YWhen you use the included rower adagter to charce your MacBook Pro, make sure the charge cable is fuly inserted irto the power adapter
before you plug the power adapter into a power outiet.

Prolonged heat exposure.

Yourr MacBook Pro and its power adapter may become very warm during romnal use. The MacBook Pro ad ts B7VY USB-C Fower Adapler, 86W USB-C
Power Adacter, of 140W USB-C Power Adapter comply with reguired surface tempearature limits defired by applicable courtry regdations and irtemational
and regional safety standards. However, even within t-ese limits, sustared contact with wam surfaces for long periods of time may causs discomfort or
irjury.

To reduce the possibility of overneating or heat-related injuries, always alow adequates ventilati on around thes MacBook Pro and its power adapter and use

care when handling them. Use commeh sense 1o avoid 5 fuaticns whare your skin is in prol orged cortact with a device or its power adagier when if's
operating or pplugged into a power source. For example, dor't sleeps with a device or power adaster whenit’s plugged irio a power source. Do notplace
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the device or power adaster under a Hanket, pillow, o yolr body when the device or adagter is cornected toa power sources Never push anything into
the ver-tilation openings, as doing so may 2 dangerous and calse your complier to overheat. hever place anytling over the keyboard when opérating
your MacBook Pro. i your MacBook Frois on your |30 ard gets uncomfortald y warm, remove it from your 1ain and pace it oma stable, well-vertilated work
surface. Take spedd care if you have a physical condition that affects your a5ility to detect heat aga nst the body.

67w USB-C Power Adapter, 96W USB-C Power Adapter, or 140w USB-C Power Adapter.
To operate the 57W LISB-C Power Adapter, 98W LSB-C Fower Adapter, or 140V USB-C Power Adapter safely and reduce te possikility of Feat-related
irjury or damag &, do ones of the following:

e Plug the B87WW USB-C Power Adaster, 86W USE-C FPower Adagter, or 140V USB-C Power Adaster directly into a power oLtlet
o If you're using thes Power Adaster Extension Cald g, place the power adapter on a desk, 1asie, or on the floor in a wel-vertilated location.

Dor'tuse your MacBook Pro or its power adagter in wet locations, such as rear asink, Batttub, or shower stall, ard do't conrnect or disconnect e
power adapter with wet hands. Unislug the power adaoter and disconrect any cables if ary of e fol owirg conditions exists.

¢ The USB-C calie or power cord has become frayed or damaged.

¢ The plug part of the 57V USB-C Power Adapster, 95V USB-C Power Adater, or 1400 USB-C Fower Adapter, the prongs, or the adapter case Fave
becomes damaged.

* Your MacBook Proor 67w USB-C Power Adapter, 96W USB-C Power Adapter, or 140w USB-C Power Adapter has been dropped.

o Your MacBook Proor 67V USB-C Fower Adapster, 86W USB-C Power Adapter, or 140W USB-C Power Adapter is exiosed torain, liguicy o excessive
mois e

e You suspect the MacBook Pro or 57W USB-C Power Adapter, 96VY USB-C Power Adaster, or 140W LSB-C Power Adaster needs service or repair.

¢ You want toclean the MadcBook Pro or BAW USB-C Power Adapter, BW USB-C Power Adapter, o 140V ILUSB-C Fower Adapter {Use odly the
recommended procedure, Cescribed in Important Fardling information for your Mac

)

Thes MagSafe 3 power pOM COMAIrs @ Magnet that Can 87858 data 0N a Credit Card, iFOd, OF Other deviCE. To BreS8rve yolr data, do Not place these o
other magnetically sensitive material or devices within 1 inch (25 ) of this jport.

If detxis gets onto the power port, remove it gently with a dry cotion swala
87w USB-C Power adaster spedfications:

L]
FreqQuency:
50 1o B0 Hz, shgle phase

Line Voltage:
10010240V

{S56-P0) Cutput Volttage:
20.3WVDC/3.34 or 18WDC/3A or BVDC/3A or 5.2VDC/3A

86WW USB-C Power adaster spedfications:

L]
Frequiency:
50 o B0 Hz, singles phase

Ling Voltage!
100t0 240V
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{S56-P0) Output Vottage:
20.5VDC/A. 74 or 18VDC/3A or SVDC/3A or 5.2VDC/34,

140w USB-C Fower adapter spedfications:

[ ]
Frequency:
50 to B0 Hz, single phase

Ling Voltage:
10010240V

{U56-PO) Output Voltage:
28VDC/54A or 20.5VDC/AA o 15VDGC/AA or SVDC/3A or 5.2VDC/34

Hearing loss.

Listening to sound at high volumes may damage your Fearnirg. Background noise, as well as contirued exposure 1o high vaume levels, can make sounds
seem guieter than they actually are. Use only compatible eauds, headphones, o eansieces with your MacBook Pro. Turn on the awdio and check the
volumes before insert ng anything into your ear. See Sourd and Hearirg

£\ WARNING:
To prevent BOSSIKE hearing damages, donotlistem at high volume leve s for [ong penods

Repairing.

Yourr MacBook Pro doesn™ haves ary user-serviceable parts. Do not open or disassemid e MacBook Pro or attemnpt to repair it o redace any components.
Disassembling your WMacBook Pro may damage it o may calse irjury to you. If you attemnpt to open your MacBodk Pro, you risk damaging your computer,
aNd SUCH dAMTAge (St COVEred (DY the [IMitéd waltanty on your MacBo0ok Pro.

If your MacBook Pro needs service is damaged, malfurctions, or comes in cortact with liqui d contact Apgle or an Apple Authorized Service Frovider for
service, Repairs performed by untrained individuals or using ron-genuire Apd & parts may affect the safety ard furctionality of the device. You can find
irformation about getiing service at Mac Repair ard Service

Navigation.

IWAIDE, directions, and [0CatON-Gas8d A0S d&0end ON data S8rviCES. ThESE datd S&rviCES arg SUbject 10 Charge and May Not B8 availdisl@ in dl Areds,
resuting in mags, directions, or location-based infamation that may Be uravailable, imaccurate, orincomplete. Compare the provided | ocation-based
irformation to your surrcuindings and defer to posted sigrs to resolve ary di screpancies. Do not use trese services while performing activities trat require
wour full attertion Always comply with posted sighs and tre apdicad e laws and regulations in the areas whers you are Lsing navigalions and always use
COMMon 58Nse.

Radio frequency exposure.
MacBook Pro LSS radio 5ignals to comnect o wireless networks. Forirformation asout radio frequency (RF) energy resuting fromradio signds ard steps
YOuU Can take tomiNmiZe exposUre, go to RF Exposure

Medical device interference,

MacBook Pro cortams magrets, as well as comoonents and radios that emit electromagnetic fisd ds. THese magnets and electomagnetic fields might
irterfers with medical dewvices. Corsult your physician ard medical device manufacturer for information specific fo your medical device, ad whether you
reed fo martan a safe distance of sepparation between your med cd device and WMadBook Pro. Marufacturers often provide recommendations on the safe
Lse of their devices around wiredess or magnelic products toprevent possible irterfererce. If you sussect MacBook Proisirterfering with your medical
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devics, Siop using your MacBook Pro. Medical devi ces sach asimid anted pacemakers and defilrillators may cortain sensors that ressond to magnets and
radios whenin close contact. To avoid ary potertia irteractiors with these devices, keep your MacBook Pro a safe distace away from your device (more
tham B inches / 15 cm), Lt consut with your prysician and your device manufacturer for specific guddines

Medical conditions.
f you have a medical condifion that you believe cold be affected by using MacBook Pro (for examg e, sazures, blackouts, eyestran, o headaches),
comsult withyour physician prior to using MacBook Pro.

Repetiive motion
When you perform rgzetitive activities such as typing o plavirg games onMacBoodk Bro, Yod may eXperience dscomfort in your hands, ams, wrists,
shoulders, nedk, or other parts of your body. If you experierce discomfort, stop using MadBook Pro and consult a physician

Choking hazard.
Some MacBook Pro Accessones may Bresert a choking hazard to smal children. Kegp these accessones away from small children.

High-consequence activilies.
Yol MacBook Prois notirtended for use where the failure of the compLier colid lead 10 death, persoral injury, OF Severe environmerta damage.

Explosive and other atrmospheric condiions.

Using MacBook Pro in any area wilh a potertially explosive atmosphere may loe hazardous—particLlaryin areas where he ar cortans highleve s of
flammaksle chemicals, vapors, oF particles such as gran, dust, o metd powders. Exposing MacBook Pro 1o enwironmeanis hawving H gh concertratiors of
irdustial chemica s, i ncluding evaorating liquified gases such as helium, may damage or impair MacBook Pro funci orality. Obeyall sigrs and
irstructions.

Important handling information for your Mac

Operating ervirorment
Operating your MacBook Pro oLtside These ranges may affect performarce:

L]
Qperating temperature;
50 to 95% F (10% 10 35 C)

Storage température.
AT o MIFF (-5 10 454 C)

Felative humidity:
0% 1o 80%4 (Moncondensing)

Operating attitude:
Tested WP 10 10,C00 feet (0 10 3048 meters)

Carrying your MacBook Pro.
If you carry your MacBook Proin a bag o brisfcases make sure there are ro Ioose items (such as paper dips o coins) that coud accidentally get inside the
computer trough vent openings or get stuck irside a port.

CAUTIONM:
Kegp ands and fingers away from the moving parts to ava d grchirg
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Using connectors and ports.
Never force a connector into the ports. When conrectinga device, make sure the port is free of debn s, that the connectar matdhes the port, ad that you
have positioned the connector correctly in relation 1o thes port.

Using the USB-C to MagSafe 3 Cable (2 m).

Certain usage patterns can cortribute to the fraying or breaking of casies The USB-C to MagSafe 3 Cable, pciured in What's induded with your MacBook
Pro

, like any other meta wire or caldg, is subject to lbecoming weak or britle i f repeatedly bent in thes same spot. Aim for gentle curves instead of angles inthe

casle. Regulary inspect the caldle and connectors for any kirks, breaks, kserds, or ot-er damage. Should you find any sudh damage, discortinue use of the
USB-C 1o MagSafe 3 Calole,

Using the USB-C Charge Cable (2 m).

Certain usage patterns can cortribute to the fraying or breaking of cables. The USB-C Charge Cabley pictured inWhat's included with your MacBook Pro

. like any other meta wire or caldlg, is subject 1o ecoming weak or britleif repeatedly bent in the same spot, aim for gentle curves instead of angles intre
casle. Regularty inspect the calde and connectors for any kirks, breaks, bberds, or of~er damace: Should yvoufind any sudh damage, discortinue use of the
USB-C Charge Cable.

Storing your MacBook Pro.

If you're going to store your MacBook Pro for an extended period of time, kesp it in a cod | ocat on {ideally, 71° For 22% C) and discharge the battery to 50
percent. YWhen storing your computer for longer 1-an five months, maintain the capacity of the battery oy tharging te battery 1o 50 percent every Sx
moriths or so.

Cleaning your MacBook Pro.

When deaning the outside of your MacBook Pro and its compengris, first shut down your MadBook Pro and unplug the charge cade and the power
adapter. Thendampen a dean, soft, lint-free cloth to wipe 1 MacBook Pro exterior Avoid gettirg moisture in ary operings. Don't sgray liquid drectlyon
the computer. Don’t use aemsol sgrays, solverts, abrasives, o clearers containing hydrogen peroxide, which might damage the finish

Cleaning the MacBook Pro SCreén,
To clean tr& MacBock Pro screen, first shut down your MacBook Pro and undug the charge cald e and the power adagter. Then dampena clean, soft, lint-
free doth with just water and wipe the screen, Dot spray liquid directly on tre screen.

Mac ergonomics
When yOul LSS the keykb0ard and MOUES, yolr Shoulders Should BE relaxed. Yol UpEer am ard foréam shoud form an ang & hat is sligrtly GreatsSr tran a
fight angles, with your wristand hard in roughly a straghtline

Not this
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Change hand positions often to avoid fatigue. Some computer users might develop d scomfort intheir hards, wrists, or arms after intensive work without
breaks. If you bbegin 1o deved op chronic pain or d scomfort in your hands, wrists, or amns, corsult a glalified health spedalist.

External mouse.
If you LS8 an extemal mouse, £ositionthe mouss at the same height as the keyisoard and within a comfortaldle reach

Chair.

An adjustable chair that provides firm, comfortasie suppport is est. Ad just tre height of thes clair so your thighs are horizorta and your feet are flat on the
floor. The back of the chair should supysort your lower Izack, lumbar regior). Follow the marufacturer’s instruct ors for adjusting the backrest to 't your
BOdy jorojCeHy.

Built-in display.
Adjust the angle of the display 1o minimize gare and reflectiors from overhead ights ad windows Do not force the display ifyoumeet resistarce. The
digzlay is not designed to ofpen past 135 degrees.

Youl can adjust the brightness of the screen when yol 1ake the computer fiomone wotk [ocation 1o anothe, o if telighting in your work area chances.

For more information about ergonomics, see the Ao e Support arti cle Ergonomics

Regulatory information

Reguilatory information, certification, and compliance marks specifc to MacBook Fro are availald e on-device: Groose Apsle meru @
= About This Mac, then click Regulatory Certification

FCC compliance statement
This device compelies with part 15 of ta FCC Ru es. Operation is sukject to te folowing two conditions: (11 this device may NCt cause harmiul interference,
and (F) this device must accest any interference received, including irterferencs that may Cause Lhdesired operation

MNaote:

This eguipmerthas been tested and found to compy with tre imits for a Class B digital device, pursLant to part 15 of the FCC Rules. These linits are
dESIGNEd 10 [Drovidd FE3asonase ProtéCtion against haful irterf2rance in a residential i Nstdllation,

This eguipmert generates, uses, ad can radiate radio frequency energy and, ifnot instad led and used in accordance with te instructions, may cause
Farmiul irterference toradio communications. However, there is no gLarantse that irterfererce will not occurina particular installation.

If thi s equipment does cause harmiful irterference to radio o television recegt on, which can be determired by tumirg the equipment off and on, the user is
encouraged to try To correct the interference by one or more of the fd lowing measures:

e Reorignt o relocats the recgiving antsnna.

¢ Increase the separation Between the equipmert and recealver.

¢ Connectthe eguisment to anoltlet on a circuit differert from that fo which the recaiver is corrected.
e Consult the dealer or an exgeienced radiofTV tednician for Felp.

Changes or modifications to this product not autharized by Agd e could void the electromagnetic compatibility (EMC) and wireless comdiancs and negate
¥OUr aLthority 1o operate the product.

This product has demonstrated BAC compliance urder conditions that ircluded the use of compliart periphera devices ard shielded cables between
system componerts. Itis importart that you use compliart perigheral devices and shiglded cables between system components to reduce the jsossibilty of
caJsing interererces toradios, 18levision sets, ard other electronic devices.

Fesponsible party (contact for FCC matters only);

Aocple Inc.
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One Aooie Park Way, MS 911-aHVY
Cuperting, CA 85014

usa

apple.com/contact

ISED Canada compliance statement

This device compli es with ISED Camada licence-exempt BSS standad({s). Operation is subject to tre followirg two condtions: (1) this device may nct
cause irterference, and (2] this device must accert any interference, including irterfererce that may cause urdesired operation of hedevice

Operation inthe tand 51505250 MHz is only for indoor use 1o reduce the potential for hamnful interference 1o co-channel moksile satellite systems

Le présent appareil est conforme aux ONR ¢’ ISDE Carada azlicables aux apparsi s radio exemizts de licence. Pexploitation est avtorisée aux daux
conditions suivantes : (1) "apparel e doit pas prodLire de broLilage et (21 Papsareil doit accepter tout kvouillage radiod ectrigue subi, méme si le
brouillage est suscertible d'en comprometire |e fonctionnement.

La pande 5150-2250 MHz est réservée: uniguement jpour une utilisation a irtérieur afin de réduire les risguies de brouillage préjudiciasle aux systémesdes
satellites mokiles uti sant iBs mémes canawx

ENERGY STAR® compliance statement

ENERGY STAR

As an ENERGY STAR partner, Apole has determined that standard corfigurations of this prodact meet the ENERGY STAR guidslines for energy efficiency.
The ENERCY STAR rogram is a partrership with d ectronic equipment manufaciurers to promiote energy-efficient products. Feduding erergy consumstion
of products saves money and helps conserva vd Lable resources.

MacBook Pro is shipised wilh power managemert eraidl ed, with the comouter set to sieep after 10 minutes of user iractivity. To wake your computer, dick
the frackqpad or press ary key cn the keyboard. To charge this setting, oppen System Settings
, Then click Lock Screen.

For more information asout ENERGY STAR, go to Bnercy Star

Apple and the environment
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At Apples, we recognize our resgonsibil ity to mirimi ze the environmental impacts of our operations and products

For information, go io Asple’s Environmert
webhsite.

Disposal and recycling information

The symbol asove means that according tolocal laws and regulations your product and/or its cattery stall be dispposed of sepa ately from housshold
waste. When this product reaches its end of life, 1ake it fo a cdlection jpart designated by loca authorities. The separate cdlection and recycling of your
product ard/or its battery at the time of disposal will help conserves natural resources and esrsure that itisrecycled in a marner that protects human health
and the environment.

For information about Azple’s recycling program, recycling collection points, restricted substances, and other ervironmerta initiatives, visit
apple.com/ervironment

Inforrnacion sobire eliminacion de residucs y reciclaje

El smbolode arrila indica gue este producto y/o su bateria no deben desedarse con | os residuos domésticos. Cuando guieras desechar estes producto
y/o su bateria, hazlo de conformnidad con las leyes y direclrices medicambiental es locales. Para olsterer masirformacicn solxe el programa de reciclaje de
Aoe, 108 puntos de recoleccion para reci daje, [as sustarcias restringidas y otras inid ativas medicambiertales, visia apple com/M/ervirooment

o asple.comAa‘environment

Brasil = Informacbes sobre descarte ¢ reciclagem

O simeolo acma indica que este produ1o e/ou 5.3 bateria N30 devem S&r descartados ro lixo doméstico- Quarco decidir descarar este produto e/ou sua
bateria, faca-o de acordo com as sis e diretrizes anis ertas locas, Fara informaches soiore suUbstarcias de use rast o, o programa de recicdagemda
Apple, pontos de coleta e telefone de informaches, visite apple comlr/erviriormert

Apple Recycling Program
For free recycling of your old device, a prepad shipping labd, and instructionrs, see Agsle Trade Inwebsite

Turkey ervircnmental information
Tankive: Cumnhuriyveti; AFEE Yonetmeliging Uygurdar.

Baftery disposal information
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The: battery inyour MacBook Pro should I2e servi ced, replaced, or recycled by Aad e or an altron zed service provider, and must be recyded or disposed
of separately fromn household waste according to your local enwironmental laws and guiddires. Forinformation akout battery service and recyding, goto
Battery Service and Recycling

Software License Agreement
Use of MacBook Pro constitutes acceptance of the Az e and third-party software license tenmns Tourd at Software License Agresmerts
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